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Preface 

This user guide: 

• Describes requirements on how to configure RAID mode on AMD platforms. 

• Provides information about arrays, disks, and RAID levels (RAID types). 

• Describes how to improve storage system performance or reliability by understanding 

array and disk tasks and options. 

• Describes the procedures on how to acquire and load RAIDXpert2 drivers for supported 

Microsoft® Windows® operating systems and Linux® operating systems. 

• Describes supported features and procedures for using RAIDXpert2, which is the 

RAIDXpert2 GUI. 

Intended Audience 

This user guide is intended for use by system administrators and technicians who are experienced 

with the following: 

• Direct Attached Storage (DAS), Storage Area Network (SAN), or Network Attached 

Storage (NAS) operators 

• Network administration 

• Network installation 

• Storage system installation and configuration 

Prerequisites 

Prerequisites for installing and configuring this product include familiarity with: 

• Servers and computer networks 

• RAID and input/output signal technology (such as SCSI, SATA, or NVMe) 

• Fibre Channel and Ethernet protocols 
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Document Conventions and Symbols 

Table 1. Document Convention 

Convention Element 

Navy blue, underlined text 

(http.//www.example.com) 

Web site addresses 

Bold font  Key names 

Text typed into a GUI element, such as into a box 

GUI elements that are clicked or selected, such as menu and 

list items, buttons, and check boxes 

Italics font Text emphasis 

Monospace font File and directory names 

System output 

Code 

Text typed at the command line 

Monospace, Italic font Code variables 

Command line variables 

Monospace, bold font Emphasis of file and directory names, system output, code, 

and text typed at the command line 

Customer Support 

For customer support, contact your system supplier or motherboard vendor. 

Glossary 

Table 2. Glossary of Terms 

Term Definition 

rcadm A command line interface (CLI) tool for managing RAID controllers on 

Linux®, on Windows®, and UEFI operating systems. It is used for 

creating, transforming, and deleting arrays; and adding and removing 

disks. 

disk Legacy disks include new or unrecognized disks which may contain data 
or even an operating system. Legacy disks appear in the RAIDXpert2 

Configuration Utility (HII) as legacy arrays. When the legacy disk is 

initialized, configuration data is written to the disk. The legacy array 

then becomes an online disk usable in arrays. 

CAUTION: A legacy disk can contain valid data. When a legacy disk is 

initialized, all data on the disk is lost. 

Linux
®
 Free, open-source UNIX-based operating system. 
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Chapter 1 Getting Started 

1.1 AMD RAIDXpert2 Technology 

AMD RAIDXpert2 consists of the following: 

• Storage management 

• RAID controller and port virtualization 

AMD RAIDXpert2 runs on existing systems by using a motherboard’s built-in SATA ports, PCIe 

M.2 slots, and PCIe NVMe add-in cards. 

1.2 Who Should Use This User Guide 

Only trained, experienced, and authorized personnel should install RAIDXpert2 and use its 

features and capabilities.  

All unit operators must be familiar with system hardware, data storage, RAID technology, 

input/output signal technology (such as NVMe, SCSI, SAS, or SATA), and Direct Attached 

Storage (DAS), Network Attached Storage (NAS), and/or Storage Area Network (SAN) concepts 

and technology.  

The intended user audience of this user guide is system administrators and experienced users. 

1.3 Supported Operating Systems 

RAIDXpert2 supports the following 64-bit operating systems. 

Mobile, desktop, and workstation: 

• Microsoft® Windows® 10 and Windows 11 

Workstation only: 

• Red Hat® Enterprise Linux® (RHEL) 8.x 

• Ubuntu® Linux 20.04.x, 22.04.x 
 

For software installation steps, refer to the following documents: 

• AMD RAID Quick Start Guide for Windows Operating Systems, order# 56268 

• AMD RAID Quick Start Guide for Red Hat (RHEL) Operating System, order# 56963 

• AMD RAID Quick Start Guide for Ubuntu Operating Systems, order# 56966 
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1.4 Controller Count and Configuration 

Table 3 shows allowable controller and configuration maximums, based on the installed driver. 

Table 3. Maximum Controller Count and Configuration 

Component For Systems with Driver 9.3.2 

Max Controller Count 18 controllers: 16 NVMe + 2 AHCI (or 15 NVMe + 3 AHCI): 

Two controllers with device ID 0x7917 or 0x43BD and NVMe (one per NVMe) 

Maximum Configuration • 22 arrays for deletion 

• 12 arrays for creation 

• 22 devices (16 NVMe + 6 SATA) 

• 8 devices per array 

Note: Desktop/Mobile/x399/Workstation systems with driver 9.3.2 support S0i3, S3, and S4. 
 

1.5 Features of RAIDXpert2 

The features of RAIDXpert2 described in Table 4 apply to all supported operating systems. 

Table 4. RAIDXpert2 Features 

RAIDXpert2 Feature Description 

Arrays (general 

information) 

RAIDXpert2 allows: 

• An array refers to data storage created by RAIDXpert2 from one or more 

disks. An array can be created from several disks, but it is seen by the 

operating system as a single disk. 

• Creating arrays of different RAID levels using the same disks. 

• Creating different RAID level arrays on the same disk to adapt each array 

to the I/O that it processes.  

• Dissimilar Disk Support within the Same Array 

• Online RAID Level Migration (ORLM) 

Array Creation Instant Create support and Create Array Functions without Rebooting: 

• No initialization 

• Foreground initialization 

• Background initialization 

Array Deletion Delete Array Functions without Rebooting 

• Single 

• Multiple 

Array Hiding • An array can be hidden from the operating system so that neither the 

software nor users can see or access it. 
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Table 4. RAIDXpert2 Features (Continued) 

RAIDXpert2 Feature Description 

Array Recovery If a redundant array is accidentally deleted, it might be recovered by 

creating a new array with the same properties as the deleted array. (This 

can occur only if disk Write Access operations are not in-progress.) 

Array Transformation Transform from one RAID level to almost any other RAID level. 

Background Array 

Initialization (BGI) 

Background initialization allows a redundant array to be used immediately. 

Data is not lost if a disk goes offline prior to completion of the BGI 

process. 

Cache Support for Arrays Various array-caching options are supported:  

• No Cache 

• Read Ahead Cache 

• Write Back Cache 

• Read Ahead and Write Back Cache 

Cache Support for Disks Various disk-caching options are supported:  

• No Cache 

• Read Ahead Cache 

• Write Back Cache 

• Read Ahead and Write Back Cache 

Note: By default, NVMe Physical disk Read Ahead and Write Back cache 

are always disabled. User cannot enable the setting because it may 

impact the operational performance of the NVMe disk. 

Controller Spanning RAIDXpert2 was architected to ensure spanning support and a common 

interface API to the underlying hardware. This allows creating a RAID 

Virtual Disk spanning across devices connected to the AMD chipset, AMD 

processor, and/or NVMe controllers. 

Consistency Check A Consistency Check is a background operation that verifies and corrects 
the mirror or parity data for fault-tolerant disks. It is recommended that a 

Consistency Check be run periodically on an array. 

Options: 

• Background redundancy check 

• Scheduled 

Device Interfaces 

Supported 
• SATA HDD 

• SATA SSD 

• M.2 SATA SSD 

• M.2 NVMe SSD 

• ATAPI 

• PCIe NVMe SSD 

• U.2 device 

• U.3 device 

Dissimilar Disk Support 

within the Same Array 

Creating an array from a mix of different type disks is allowed but not 

recommended because of the performance impacts. 

For example, a RAID10 array can be created from a group of disks that 
contain two SATA HDDs and two SATA SSDs, or only one NVMe or a 

group of SATA and NVMe disks. 
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Table 4. RAIDXpert2 Features (Continued) 

RAIDXpert2 Feature Description 

Drive/Disk Roaming With disk roaming, SATA cables can be disconnected from their disks and 

shuffled without confusing RAIDXpert2. 

Note: Disconnect SATA cables from disks only when system is shutdown. 

Disk roaming allows: 

• Same system: Devices can be moved to different locations; RAIDXpert2 

detects which devices belong to which arrays, regardless of device 

location. 

• Between systems: Device(s) to be moved between systems. 

Note: It might not be possible to move disks between systems if they 

contain the AMD RAID boot array. 

Fault Tolerance The following fault tolerance features are available with RAIDXpert2 to 

prevent data loss in case of a failed disk. 

• Disk failure detection (automatic). 

• Array rebuild using hot spares (automatic if the hot spare is configured 

for this functionality). 

• Hot swap — the manual replacement of a SATA device without 

rebooting the system (only available in systems with backplanes that 

support hot swap) 

Note: Hot swapping is not recommend for disks that are part of the Boot 

Virtual Disk or are connected to the AMD RAID supported chipsets. 

This applies to all chipsets. 

Hot-Swap Support Hot-swapping is not recommended for disks that are part of AMD RAID 

boot array. 

Mirror Rebuilding A broken mirrored array can be rebuilt after a new disk is inserted and the 

disk is designated as a spare. The system does not require rebooting. 

Native Command Queuing 

(NCQ) 

Native Command Queuing is a command protocol of SATA disks that are 

supported by RAIDXpert2. NCQ enables individual disks to internally 

optimize the order in which Read and Write commands are executed. 
RAIDXpert2 permits a maximum queue depth of up to 32 read/write 

commands per disk. 

Online Capacity 

Expansion (OCE) 

OCE is a process that allows the user to add storage capacity to an existing 

array without taking the system offline. It enables the user to increase total 

storage capacity of an array by integrating unused storage into the array. 

Data can be accessed while the disks are added and while data on the array 

is being redistributed.  
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Table 4. RAIDXpert2 Features (Continued) 

RAIDXpert2 Feature Description 

Online RAID Level 

Migration (ORLM) 
• Users can easily move an array from one RAID level to another. This 

can be useful if the array type used is not the optimal type for the 

application. 

• This function depends on array capacity, redundancy level, and capacity 

of the drive or free space available. 

• While the migration is taking place, data is accessible and protected to 

the lowest protection of either the source RAID level or the destination 

RAID level. 

RAID Level Support RAIDXpert2 supports: 

• RAID levels 0, 1, 10, Volume, and RAIDABLE 

• RAID5 support only for AMD Family 17h Models 31h sTRX4/sWRX8 

processors 

• Multiple RAID Levels per Disk: Support for multiple array levels per 
disk allows the administrator to create arrays of different RAID levels 

using the same disks. 

Restore (Rebuild) Priority RAIDXpert2 has the ability to set the Priority of the restore task. 

Secure Erase All data on an array can be erased and ensured it is unrecoverable, even 

with advanced data recovery techniques. 

Self-Monitoring Analysis 

and Reporting Technology 

(SMART) 

SMART is a hard-disk-drive (HDD) capability that allows reliability 

information reporting. If a drive anticipates a high likelihood of future 
failure, it triggers a SMART error condition. RAIDXpert2 presents this 

error condition so the drive can be replaced before the predicted failure. 

Sparing Global — Spare disk that is shared by multiple arrays 

Dedicated — Spare disk assigned to a specific redundant array 

Trim Support Allows the OS to inform the SSD about deleted data so it can optimize 

performance. Simple and Advanced Trim types are supported. 

UEFI Driver (BIOS) 

Support 
• Create array 

• Delete array 

• RAIDXpert2 Configuration Utility (HII) 

• EFI shell utility (rcadm) 

 

 



  

AMD RAID User Guide 53987 Rev. 3.20 September 2023 

 

22 Understanding Arrays, Disks and RAID Levels  Chapter 2 

 

[Public] 

Chapter 2 Understanding Arrays, Disks and 

RAID Levels 

2.1 Understanding Arrays 

Arrays are several disks that are grouped together to improve either the performance or reliability 

of a storage system. Because some RAID levels enhance performance while others improve 

reliability, it is important to consider the user’s needs when planning an array configuration. 

Note: It is highly recommended that this user manual be reviewed in its entirety before 

configuring arrays. Some of the advanced features of RAIDXpert2 (such as sparing options) 

must be understood by the user before creating arrays. 

2.2 RAID Levels 

RAIDXpert2 supports the RAID levels indicated in Table 5. 

Table 5. RAID Levels – General Characteristics 

RAID Level Main Characteristic Use/Usefulness 

RAID0 (Striping) • Provides the highest performance 

but no data redundancy. Data in 
the array is striped (distributed) 

across several disks. 

• Supports 2-8 disks. 

• RAID0 arrays are useful for 

holding information, such as the 
operating system paging file, 

where performance is extremely 

important, but redundancy is not. 

RAID1 

(Mirroring) 
• Mirrors data on a partition of one 

disk to another. 

• Supports 2 disks. 

• Useful when there are only two 

disks available and data integrity 

is more important than storage 

capacity. 

RAID10 (Striped 

RAID1 Sets) 
• Combines mirrors and stripe sets. 

RAID10 allows multiple disk 

failures, up to 1 failure in each 

mirror that has been striped. 

• Supports 4, 6, or 8 disks. 

• Offers better performance than a 

simple mirror because of the extra 

disks.  

• Requires twice the disk space of 

RAID1 to offer redundancy. 
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Table 5. RAID Levels – General Characteristics (Continued) 

RAID Level Main Characteristic Use/Usefulness 

RAID5 • RAID5 is only supported for 

AMD Family 17h Models 31h 

sTRX4/sWRX8 processors.. 

• Stripes data as well as parity, 
across all disks in the array. 

• In the event of a failure, 

RAIDXpert2 can restore the lost 

data of the failed disk from the 
other surviving disks. 

• Supports 3-8 disks. 

• Offers exceptional read 

performance and redundancy. 

• Write performance is not an issue 
due to the tendency of the 

operating system to perform many 

more reads than writes. 

• Requires only one extra disk to 

offer redundancy. 

• For most systems with three or 

more disks this is the correct 

choice for a RAID level. 

Volume (JBOD) • RAIDXpert2 treats one or more 

disks or the unused space on a 

disk as a single array.  

• Supports 1 to 8 disks 

Provides the ability to link-together 

storage from one or several disks, 

regardless of the size of the space on 

those disks. 

Useful in scavenging space on disks 

unused by other disks in the array. 

Does not provide performance benefits 

or data redundancy. Disk failure will 

result in data loss. 

RAIDABLE (also 

known as RAID 

Ready) 

• Allows a RAIDABLE disk to be 

transformed later to RAID0 or 

RAID1. 

• Supports one disk. 

See RAID0 (Striping), on page 22 or 
RAID1 (Mirroring) on page 22 for 

post-transformation usefulness. 

2.3 Array States 

Within the management applications, an array is a logical device that can exist in one of four 

states: Normal, Ready, Critical, or Offline.  

• In RAIDXpert2, these states display in the Array List section in a column named State.  

• Within the rcadm Command Line interface, these states also display in a column named 

State.  

The array states are defined in Table 6, on page 24. 
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Table 6. Array States 

State Description 

Normal The Normal state is displayed when everything is functioning correctly. 

Ready The Ready state is displayed while an array is being created. 

Critical The Critical state is displayed when the array is no longer redundant (fault 

tolerant) because of one or more disk failures. Arrays can still be read and written 

to, but the data is no longer protected should another disk fail. 

Offline The Offline state is displayed when arrays cannot be read or written to because of 

one or more disk failures. 

 

Whether an array is marked as Critical or Offline depends upon what RAID level it is and how 

many disks within the array have failed. Note the changes in state in Table 7. 

Table 7. Device Failure by RAID Level 

RAID Level Failure State Is Displayed Whenever 

RAID1  

(Redundant Arrays) 

Critical A single disk fails. 

Offline Two disks fail. 

RAID10 

(RAID Levels with Multiple 

Redundancies) 

Critical A single disk fails in any one of the sets. 

Offline All the disks in a set fail. 

Volume, RAIDABLE and RAID0 Offline A single disk fails. 

RAID5 

(Redundant Array) 

Critical A single disk fails. 

Note: RAID5 is only supported for 

AMD Family 17h Models 31h 

sTRX4/sWRX8 processors. 

Offline Two disks fail. 

 

More than one array can be created using the same set of disks. If a disk is disconnected that 

belongs to more than one array, only the arrays that try to access the disk and receive I/O errors 

report the failure. For example: there are two arrays, both of which are RAID1 sets and both use 
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disk 4. If a system that is being used by array 1 receives an I/O error when trying to communicate 

with disk 4, the state of array 1 changes to Critical. However, the state of array 2 using disk 4 does 

not change to Critical until an I/O error is reported. If systems using array 1 are not 

communicating with failed disk 4, the state of array 1 still displays as Normal.  

If a rescan of all channels is performed after disconnecting a disk, the state of every array using 

the missing disk changes from Normal to either Critical or Offline, depending on the RAID level. 

See Section 2.9, Rescanning Disks for Changes in State, on page 29 for a discussion of when to 

rescan disks and the outcomes when doing so. 

2.4 Creating Arrays: Future Expansion 

When creating arrays, consider whether disk capacity needs to expand in the future. If the file 

system must be expanded, perform the tasks indicated in Table 6 

Table 8. Array Expansion Considerations 

Operating 

System 
Do This... And Consider This... 

Microsoft
®
 

Windows
®
 

Format the arrays with NTFS. 

Microsoft Corporation provides a 

utility (Diskpart.exe) that can 
dynamically extend an NTFS file 

system onto any unused adjacent space.  

Note also that using a single partition 

per array makes expansion much easier. 

1. The Diskpart.exe utility version depends on 

which version of the Windows operating 

system is running. 

2. The Diskpart.exe utility can be found on the 
CD for some versions of Windows operating 

systems, or on the Microsoft Corporation 

website (http://www.microsoft.com) for 

other versions. Use the correct version for the 

operating system. 

Linux
®
 Use an expandable file system. Because RAIDXpert2 software is limited to 

eight arrays, if a large number of logical 

volumes are needed, use a logical volume 

manager (LVM). 

 

2.5 Expanding Disk Capacity Online: Using OCE 

Online Capacity Expansion (OCE) allows: 

• Adding disks to an array at any time to increase an array’s capacity.  

• Accessing the array data while it is being redistributed.  

To increase the size and organization of an array, transform the array. For more information about 

transforming arrays, see Section 4.4.3, Transform Arrays on page 55. 

http://www.microsoft.com/
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2.6 Migrating RAID Levels Online: Using ORLM  

Online RAID Level Migration (ORLM) allows an array to move from one RAID level to almost 

any other RAID level. This task includes migrating the array from a non-redundant RAID level to 

a redundant RAID level.  

Prior to starting a RAID level migration/transformation, make sure that the disks selected for the 

destination array have sufficient capacity. RAID level migration/transformation can occur only 

when the destination array has the same or larger capacity as the source array. 

While the migration/transformation is taking place, data is accessible and protected to the lowest 

protection of either the source RAID level or the destination RAID level. 

The Transform task can also be used to expand the capacity of an array, by using OCE. It can also 

be used as part of the system backup and recovery strategy using the RAID1 and RAID10 levels. 

To perform this process, see Section 4.4.3, Transform Arrays on page 55. 

2.7 Array Tasks: Starting and Stopping Tasks 

Tasks are started when one of the following actions are performed: 

• Create a redundant array. 

• Transform an array. 

• Restore an array. 

• Securely erase an array. 

• Check for consistency on redundant arrays. 

• Verify that data was not corrupted after a system crash (Check Bitmap performed 

automatically). 

Full task control can be used on Create, Consistency Check, and Bitmap Check tasks. On a 

Transform or Restore task for dedicated and global spares, task control can only pause/resume, but 

it cannot remove the task. To remove these types of tasks, pause and then remove them. 

The tasks indicated in Table 9 on page 27, can be displayed for each array. 
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Table 9. Types of Tasks per Array 

Task When Displayed 

Transform While an array is being transformed. 

Create While an array is being created. 

Consistency 

Check  

While verifying the mirror disk (RAID1 or RAID10) consistency is correct. 

(For redundant type arrays only.)  

Restore While an array is being restored. 

Secure Erase While an array secure erase is being performed. 

Check_Bitmap While verifying that the mirror halves on a RAID1 or RAID10 set, are 
consistent. This action is performed automatically to ensure that data is not 

corrupted whenever a system crashes. 

Not_Active When no other tasks are being performed. 

2.8 Understanding Disks 

 Disks States 

Within the management applications, a disk can be part of one or more arrays and can exist in one 

of five states: Online, Offline, New, Legacy, or SMART Error. 

• In RAIDXpert2, these states are displayed in the Disk List section in a column named 

State. See Table 16, on page 46, for additional information. 

• Within the rcadm command line interface, these states are also displayed in a column 

named State. See Table 28, on page 69, and Table 29, on page 71, for additional 

information. 

The disk states are defined in Table 10. 

Table 10. Disk States 

Disk State When Displayed 

Online Whenever the disk is connected, functioning correctly, and RAIDXpert2 can 

communicate with it. 

 



  

AMD RAID User Guide 53987 Rev. 3.20 September 2023 

 

28 Understanding Arrays, Disks and RAID Levels  Chapter 2 

 

[Public] 

Table 10. Disk States (Continued) 

Disk State When Displayed 

New Whenever an uninitialized, new disk is connected. 

Legacy Whenever a disk containing non-RAIDXpert2 configuration data is connected. 

Offline Whenever the disk fails and RAIDXpert2 detects an error condition on the disk. 

SMART Error Whenever the disk reports a SMART error(s) to RAIDXpert2. 

A disk can be a member of multiple arrays. A disk failure in one array doesn't necessarily mean it 

has failed in other arrays.  

After a rescan is performed the following can occur: 

• A disconnected disk no longer appears in the Disk List (although the disk appears as 

Missing in the Array View for the arrays to which it belonged).  

• A disk that experiences a catastrophic failure appears in the Disk List as Offline and is 

highlighted in red. The disk appears as Failed for the arrays to which it belonged. 

• A disk that has a SMART error appears in the Disk List as SMART Error. (A disk with a 

SMART error cannot be used to create an array) 

• A disk that experiences a software-related failure appears in the Disk List as Online and is 

highlighted in red. New arrays can be created with the disk.  

Arrays that exist on a failed or disconnected disk might not be designated as Failed or Missing 

until the system attempts to communicate with the failed or disconnected disk. 

 Disks 

A legacy disk is a disk that contains valid data from a Non-AMD RAID controller.  

A legacy disk appears in RAIDXpert2 GUI and RAIDXpert2 Configuration Utility (HII) with a 

corresponding legacy array. When the legacy disk is initialized in RAIDXpert2 GUI and 

RAIDXpert2 Configuration Utility (HII) the legacy array disappears. 

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted the data is lost. 

2.8.2.1 Legacy Disk and New Disk 

Table 11 provides information on how disks appear in RAIDXpert2 GUI and RAIDXpert2 

Configuration Utility (HII). 
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Table 11. New and Legacy Disks, as They Appear in the RAIDXpert2 Configuration Utility 

(HII) and RAIDXpert2 

Status of the Disk RAIDXpert2 Utility In the BIOS Configuration 

Utility/RAIDXpert2 

Configuration Utility (HII) 

New, un-initialized disk. The disk appears as a new disk 

with a legacy array. 

When the new disk is 

initialized, its state changes to 

Online (or similar). 

The disk appears as a new disk 
(the disk can appear with a 

legacy array). 

When the new disk is 

initialized, RAIDXpert2 
configuration data is written to 

the disk. The disk state changes 

to Online. 

A disk containing non-

RAIDXpert2 configuration 

data. 

CAUTION: A legacy disk can 

contain valid data. When a 

legacy array is deleted, or 
when its corresponding legacy 

disk is initialized, the data is 

lost. 

The disk appears as a legacy 

disk with a legacy array.  

When the legacy array is 

deleted, the legacy array 

disappears and the legacy disk 

type changes to Disk. The disk 
can now be used in 

RAIDXpert2 arrays. 

The disk appears as a legacy 

disk with a legacy array. 

When the legacy array is 

deleted the state of the legacy 

disk changes to Empty. The 

disk can now be used in 

RAIDXpert2 arrays. 

Note: A Native AHCI installation will not boot into the OS, after changing the BIOS settings to 

RAID mode. 

See Chapter 4, AMD RAIDXpert2 Graphical User Interface (GUI), on page 44, for the disk 

initialization procedure and the appearance of legacy disks in the BIOS Configuration Utility. 

2.9 Rescanning Disks for Changes in State 

The information displayed in the Disk List section is the state of the disks when they were last 

scanned. If a rescan has not been performed, the information displayed is the state of the disks at 

boot time. 

Every time a disk is connected or disconnected while online, a message asks if the user wants to 

perform a rescan (of all SATA channels). If Rescan is selected, the information in both the Array 

List and the Disk List is updated. This view might show arrays as being in a Critical or Offline 

state if all disks have not been installed or removed. 

Although it is highly recommended that the system be shut down before adding or removing disks, 

disks can be added or removed while the system is online (“hot-swapping”), if the system supports 
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the hot-swapping function. This is not recommended for disks that are part of the Boot Virtual 

Disk or those that are connected to the AMD RAID supported chipsets. 

Because of this function, RAIDXpert2 does not automatically perform a rescan when it detects 

that a disk has been added or removed. For example, to hot-swap a RAID1 set with two disks into 

a new system, do not perform a rescan until both disks have been connected. 

Arrays associated with the disks that are not yet connected change state to either Critical or 

Offline. In the example above, if the state of the RAID1 set changes to Offline, data is unavailable.  

Rescanning can also result in the state of a disk being reported differently in the Array View and 

the Disk List. A disk within an array can have a state of Failed in the Array View field, while at 

the same time it can show a state of Online in the Disk List. 

2.10 Sparing Options: Disks and Arrays 

RAIDXpert2 supports multiple sparing options. Spares are restored in the order indicated in 

Table 12. 

Table 12. Sparing Options 

Option Description 

Dedicated A spare disk assigned to a specific redundant array. 

Global A spare disk that is shared by multiple arrays. 

 

Note: An array is marked Critical or Offline if a disk reports a Failed state to an I/O, or if the 

Disk, SATA cable, or power cable is disconnected. 

Note: One or more spares can be assigned to a redundant RAID level. 

Note: Spare assignments do not apply to non-redundant RAID levels. To protect data, transform 

the array to a redundant RAID level. Spares can then be assigned.  

 Dedicated Sparing 

A dedicated spare is a disk that is assigned as an alternate disk for a specific array. Should a disk 

fail in that array, the alternate disk is used to replace the failed disk and the array is rebuilt.  

A dedicated spare can be assigned to any redundant array type, and up to four spares can be 

assigned to an array. 

Note: Disk capacity of the Dedicated Spare must be greater or equal to the capacity of the 

smallest disk in the array. 
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CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an 

automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the 

disk for the fail-over to complete, or assign a different disk with enough space. If a 

dedicated spare is assigned and a disk fails, the restore process starts automatically, 

if there is enough space available on the dedicated spare. 

For additional information, see Section 4.4.12, Add or Remove Dedicated Spares, on page 62.  

 Global Sparing 

A global spare is a disk that is assigned as an alternate disk for multiple arrays, instead of 

associating it with only one array.  

Many arrays can be restored using the global spare disk, if it is not already part of the array and it 

has enough space available. Unlike a dedicated spare, this type of spare can be assigned at any 

time, even while tasks are running on arrays. 

Assigning a disk for use as a global spare does not reserve space on that disk. An automatic restore 

is not guaranteed if a disk fails.  

If there is not enough disk space on the global spare, make room for the fail-over to complete, or 

assign a different disk with enough capacity as the spare. If there is enough space available on the 

global spare and a disk failure occurs, the restore process starts automatically. 

For additional information, see Section 4.4.13, Add or Remove Global Spares, on page 63.  

2.11 RAID Performance Considerations 

With RAID technology, performance is based on the following considerations:  

• The number and organization of disks in an array. 

• Caching attributes used for the array. 

• Application workload. 

• Array level verifies that the array creation completes before running performance testing. 

Note: AMD recommends not using SMR hard drives with AMD RAID systems because it can 

cause poor performance or failures. SMR drives are not suitable for workloads that require 

many random writes (such as boot drive). If used with RAID, the multiple SMR drives and 

background RAID tasks (such as creates and rebuilds) compound any issues or problems. 

 Number and Organization of Disks 

RAID functions increase performance by putting more disks to work and by buffering data for the 

host.  
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Many disks can transfer data at greater than 100 MB per second. RAIDXpert2 can aggregate this 

bandwidth in an almost linear fashion, as more of the same disks are included in an array. 

 Caching Attributes 

Arrays can also be configured to provide Read and Write Back cache, Write Back, Read Ahead 

cache, and No cache option with RAIDXpert2 configuration utility and GUI utility, if desired. 

Write Back caching has a large effect on most workloads but should be used with caution. 

 Application Workload 

When configuring an array, workload is probably the most important performance variable. Most 

applications do many more reads than writes. The best performance is obtained with array types 

like RAID0 or RAID10. 

2.12 RAID Reliability Considerations 

RAID reliability is enhanced through data redundancy and backup.  

 Data Redundancy 

RAID1, RAID5, or RAID10 are necessary for redundancy. With redundancy, both capacity and 

performance are sacrificed for reliability. With RAIDXpert2, extremely high performance is 

obtained even with redundant-type arrays. 

Note: RAID5 is only supported for AMD Family 17h Models 31h sTRX4/sWRX8 processors. 

 Backup 

It is good practice to back up your data periodically in case of a catastrophic failure. Tape backup 

or other media can be used to secure your data. 

2.13 Multiple RAID Levels 

With RAIDXpert2, different RAID levels can be created on the same disk, to adapt each array to 

the I/O that it processes. Also, more than one array can be created per disk. 

Depending on the array capacity and redundancy level, an existing array can be transformed to 

another RAID level, if the level of the array being used is not the optimal RAID level for the 

application. Also, different arrays with different characteristics can be built for different 

applications. 

 



  

53987 Rev. 3.20 September 2023 AMD RAID User Guide 

 

Chapter 3 AMD RAIDXpert2 Configuration Utility (HII) 33 

 

[Public] 

Chapter 3 AMD RAIDXpert2 Configuration 

Utility (HII) 

The RAIDXpert2 Configuration Utility is also known as the HII. Use the utility to accomplish the 

procedures indicated in Table 13. 

Table 13. When to use the AMD RAID RAIDXpert2 Configuration Utility (HII) 

Procedure Description Find Information At 

Initialize a new 

disk 

To initialize a new disk drive for data 

storage. 

Section 3.2, Initialize Disks, on page 34 

Create Arrays Create arrays at different RAID levels 

(depending on the license level for the 

system) 

Section 3.3, Create Arrays, on page 35 

Delete Arrays Delete an array Section 3.4, Delete Arrays, on page 39 

Manage hot 

spares 

Allows selection of global and 

dedicated hot spares. 
Section 3.5, Manage Spares, on page 40 

View Controller 

details 

View information about each 

controller.  
Section 3.6, View Controller Details, on page 41 

Section 3.7, View Disk Details, on page 42 

View Disk details View information about each disk. Section 3.6, View Controller Details, on page 41 

View Array 

details 

View information about each array. Section 3.7, View Disk Details, on page 42 

Rescan all 

channels 

Rescan all channels to detect new or 

removed disks and arrays. 

Section 3.9, Rescan All Channels,  on page 43 

3.1 Access the AMD RAIDXpert2 Configuration Utility 

(HII) 

AMD SP3-Series Chipsets BIOS is based on AMI BIOS. To enter the RAIDXpert2 Configuration 

Utility (HII complete the following. 

Note: The following step(s) is specific to AMD NDA BIOS. 
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1. Power ON the system. 

2.  Press DEL.  

3. In the Menu Bar, select Advanced. 

4. Select RAIDXpert2 Configuration Utility, then press Enter. 

AMD Socket AM4-Compatible Processor is based on Insyde BIOS. To enter the RAIDXpert2 

Configuration Utility (HII) complete the following: 

1. Power ON the system. 

2. Press ESC. 

3. Select Device Management, then press Enter.  

4. Select RAIDXpert2 Configuration Utility, then press Enter. 

Note: If the BIOS Configuration Utility does not display, contact your system or motherboard 

supplier. 

3.2 Initialize Disks 

New disks and legacy disks must be initialized before they can be used to create an AMD RAID 

array. 

Initialization writes AMD RAID configuration information (metadata) to a disk. 

CAUTION: If a disk is part of an AMD RAID array, the disk cannot be selected for initialization. 

To initialize the disk anyway, delete the AMD RAID array. Data on the disk is deleted 

during initialization so ensure the correct disks are chosen to initialize. 

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, all data on the 

disk is lost. 

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Physical Disk Management, then press Enter. 

2. Select Select Physical Disk Operations using the arrow keys, then press Enter. 

3. Highlight Initialize Disk using the arrow keys, then press Enter 

4. Select the disk(s) to initialize: 

a. To select individual disks, highlight a disk with the arrow keys and press the space bar or 

Enter. Multiple disks may be selected using this method. 

b. When the desired number are selected, use arrow keys to select OK, then press Enter. 

c. Review the warning message, if you want to proceed, use the arrow keys to select YES, 

then press the Enter key, or press ESC to cancel the initialization. 

Initialization takes 10 to 15 seconds per disk. During initialization, a complete rescan of all 

channels is done automatically. 
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3.3 Create Arrays  

Arrays can be created after the disks are initialized. See Section 2.2, RAID Levels, on page 22, for 

deciding what type of RAID levels to use for the array.  

TIP: See also Section 4.4.1, Create and Format Arrays  on page 52, and Section 5.4, Create New 

Arrays: rcadm --create, on page 73. 

 Before You Begin 

• In some circumstances, more than eight arrays are possible. They might appear to function 

properly but are not supported by AMD RAIDXpert2. 

• For redundant arrays the Create process starts after the operating system and AMD RAID 

OS drivers are installed and the system is booted to the operating system. However, the 

arrays are immediately available to use for either a bootable array or a data array. 

• Array numbers are valid only for a given boot and might be different in the RAIDXpert2 

Configuration Utility (HII) and RAIDXpert2 GUI. If a permanent label is required, use the 

RAIDXpert2 GUI Array Naming feature. 

• At any point in the procedure return to a prior window by pressing ESC. 

• If the system is booted from an AMD RAID bootable array the first array in the Arrays 

section must be the bootable array. The system boots only from the first array in the 

Arrays section. 

• AMD recommends not using SMR hard drives with AMD RAID systems because it can 

cause poor performance or failures. SMR drives are not suitable for workloads that require 

many random writes (such as boot drive). If used with RAID, multiple SMR drives and 

background RAID tasks (such as creates and rebuilds) compound any issues or problems. 

 Create an Array 

Before proceeding with array create and manage, System BIOS configuration should be setup as 

mentioned in the Quick Start Guide section “Platform BIOS RAID Configuration Prerequisites” 

for system RAID mode to be enabled. 

Note: The following step(s) are specific to AMD NDA BIOS. AMD SP3-Series Chipsets BIOS is 

based on AMI BIOS. AMD Socket AM4-Compatible Processor is based on Insyde BIOS. 

The RAIDXpert2 Configuration Utility can be used to create a bootable array with levels 

Volume, Raidable, RAID0, RAID1, RAID5 and RAID10. Configure array cache and Cache 

tag size settings by following the steps mentioned in the following sections. 



  

AMD RAID User Guide 53987 Rev. 3.20 September 2023 

 

36 AMD RAIDXpert2 Configuration Utility (HII)  Chapter 3 

 

[Public] 

Table 14. Default Cache Tag Size 

Array Type Default CTS 

HDD Array 

SSD Array 

Mix of HDD/SSD Array  

64 K 

All NVMe Array  256 K 

Mix of NVMe with HDD/SSD Array 256 K 

Caution: Cache Tag Size for an array cannot be changed after creation. 

To install the operating system and RAIDXpert2 files see instructions for software installation in 

the Quick Start Guide. 

3.3.2.1 Create an AMD RAID Bootable Array 

To install the operating system, AMD RAID Device driver and RAIDXpert2 GUI utility see  

instructions for software installation in the Quick Start Guide.  

CAUTION: Do not use eSATA drives for bootable arrays as they are removable. 

3.3.2.2 Create a RAIDABLE Array 

Note: Refer to Table 5 for RAIDABLE array characteristics. 

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Array Management, then press Enter. 

2. Select Create Array using the arrow keys, then press Enter. 

3. Select Select RAID Level using the arrow keys, then press Enter. 

4. From the Select RAID Level Drop down menu, use the arrow keys to select RAIDABLE, 

then press Enter. 

5. Select the disk with which to create the array: 

6. Select Physical Disks using the arrow keys, then press Enter. 

7. Select an individual disk, highlight a disk using the arrow keys and press the space bar or 

Enter.  

• Select Apply Changes using the arrow keys, then press Enter. 

Note: Refer to Table 14 on page 36 for Default Cache Tag Size. 

8. Select Read Cache Policy using the arrow keys, then press Enter. 

• Select the desired Read Cache Policy, then press Enter. 

9. Select Write Cache Policy using the arrow keys, then press Enter. 

• Select the desired Write Cache Policy, then press Enter. 

10. Select Create Array using the arrow keys, then press Enter. 
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3.3.2.3 Create a VOLUME Array 

Note: Refer to Table 5 for VOLUME array characteristics  

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Array Management, then press Enter.  

2. Select Create Array using the arrow keys, then press Enter.  

3. Select Select RAID Level using the arrow keys, then press Enter.  

• From the Select RAID Level drop-down menu, use the arrow keys to select 

VOLUME, then press Enter.  

4. Select the disks with which to create the array:  

a. Select Physical Disks using the arrow keys, then press Enter.  

b. Select desired disks, highlight a disk (arrow keys), and press the space bar or Enter.  

c. Select Apply Changes using the arrow keys, then press Enter. 

Note: Refer to Table 14 on page 36 for Default Cache Tag Size. 

5. Select Read Cache Policy using the arrow keys, then press Enter.  

• Select the desired Read Cache Policy, then press Enter.  

6. Select Write Cache Policy using the arrow keys, then press Enter.  

• Select the desired Write Cache Policy, then press Enter.  

7. Select Create Array using the arrow keys, then press Enter.  

3.3.2.4 Create a RAID0 Array  

Note: Refer to Table 5 for RAID0 array characteristics  

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Array Management, then press Enter.  

2. Select Create Array using the arrow keys, then press Enter.  

3. Select Select RAID Level using the arrow keys, then press Enter.  

• From the Select RAID Level drop-down menu, use the arrow keys to select 

RAID0, then press Enter.  

4. Select the disks to create the array:  

a. Select Physical Disks using the arrow keys, then press Enter.  

b. Select desired disks, highlight a disk with the arrow keys and press the space bar or 

Enter. 

c. Select Apply Changes using the arrow keys, then press Enter. 

Note: Refer to Table 14 on page 36 for Default Cache Tag Size. 

5. Select Read Cache Policy using the arrow keys, then press Enter. 

• Select the desired Read Cache Policy, then press Enter. 
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6. Select Write Cache Policy using the arrow keys, then press Enter. 

• Select the desired Write Cache Policy, then press Enter. 

7. Select Create Array using the arrow keys, then press Enter. 

3.3.2.5 Create a RAID1 Array  

Note: Refer to Table 5 for RAID1 array characteristics  

1. From the RAIDXpert2 Configuration Utility’s Main Menu, select Array Management 

using the arrow keys, then press Enter.  

2. Select Create Array using the arrow keys, then press Enter.  

3. Select Select RAID Level using the arrow keys, then press Enter.  

• From the Select RAID Level drop-down menu, use the arrow keys to select 

RAID1, then press Enter.  

4. Select the disks to create the array: 

a. Select Physical Disks using the arrow keys, then press Enter.  

b. Select desired disks, highlight a disk with the arrow keys and press the space bar or 

Enter.  

c. Select Apply Changes using the arrow keys, then press Enter. 

Note: Refer to Table 14 on page 36 for Default Cache Tag Size. 

5. Select Read Cache Policy using the arrow keys, then press Enter.  

• Select the desired Read Cache Policy, then press Enter.  

6. Select Write Cache Policy using the arrow keys, then press Enter.  

• Select the desired Write Cache Policy, then press Enter.  

7. Select Create Array using the arrow keys, then press Enter.  

3.3.2.6 Create a RAID10 Array  

Note: Refer to Table 5 for RAID10 array characteristics  

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Array Management, then press Enter.  

2. Select Create Array using the arrow keys, then press Enter.  

3. Select Select RAID Level using the arrow keys, then press Enter.  

• From the Select RAID Level drop-down menu, use the arrow keys to select 

RAID10, then press Enter.  

4. Select the disks with which to create the array:  

a. Select Physical Disks using the arrow keys, then press Enter.  

b. Select desired disks, highlight a disk with the arrow keys and press the space bar or 

Enter.  
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c. Select Apply Changes using the arrow keys, then press Enter.  

Note: Refer to Table 14 on page 36 for Default Cache Tag Size. 

5. Select Read Cache Policy using the arrow keys, then press Enter.  

• Select the desired Read Cache Policy, then press Enter.  

6. Select Write Cache Policy using the arrow keys, then press Enter.  

• Select the desired Write Cache Policy, then press Enter.  

7. Select Create Array using the arrow keys, then press Enter. 

3.3.2.7 Create a RAID5 Array  

Note: Refer to Table 5 for RAID5 array characteristics.  

Note: RAID5 is only supported for AMD Family 17h Models 31h sTRX4/sWRX8 processors. 

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Array Management, then press Enter.  

2. Select Create Array using the arrow keys, then press Enter.  

3. Select Select RAID Level using the arrow keys, then press Enter.  

• From the Select RAID Level drop-down menu, use the arrow keys to select 

RAID5, then press Enter.  

4. Select the disks to create the array:  

a. Select Physical Disks using the arrow keys, then press Enter.  

b. Select desired disks, highlight a disk with the arrow keys and press the space bar or 

Enter. Select a minimum of three (3) devices for RAID5. 

c. Select Apply Changes using the arrow keys, then press Enter.  

Note: Refer to Table 14 on page 36 for the Default Cache Tag Size. 

5. Select Read Cache Policy using the arrow keys, then press Enter.  

• Select the desired Read Cache Policy, then press Enter.  

6. Select Write Cache Policy using the arrow keys, then press Enter.  

• Select the desired Write Cache Policy, then press Enter.  

7. Select Create Array using the arrow keys, then press Enter. 

3.4 Delete Arrays 

CAUTION: Deleting an array permanently destroys all the data on the array. This action cannot 

be undone, and it is very unlikely the data can be recovered. 

CAUTION: Do not delete the first array listed in the Arrays section if it is the AMD RAID 

bootable array. Doing this deletes the operating system and AMD RAID files. 



  

AMD RAID User Guide 53987 Rev. 3.20 September 2023 

 

40 AMD RAIDXpert2 Configuration Utility (HII)  Chapter 3 

 

[Public] 

CAUTION: Deleting secondary arrays in the RAIDXpert2 Configuration Utility (HII) after the 

system resumes from a hibernation results in the arrays not being deleted. The system 

boots from the previous hibernation configuration. If you want to delete secondary 

arrays in RAIDXpert2 Configuration Utility (HII), reset the system, then enter 

RAIDXpert2 Configuration Utility (HII) and perform the delete. 

 Delete an Array 

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Array Management, then press Enter. 

2. Select Delete Arrays using the arrow keys, then press Enter.  

3. Select the array(s) to delete: 

a. Select the desired array or multiple arrays using the arrow keys, then press the space 

bar or Enter to change option to Enabled for deletion. 

b. If you want to select all the arrays, use the arrow keys to select Check all, then press 

Enter. 

c. Select Delete Array using the arrow keys, then press the space bar or Enter. 

d. To select all the arrays for deletion: use the arrow keys to select Check all, then press 

the space bar or Enter. 

e. Review the warning message, if you want to proceed, press the space bar or Enter. 

f. Select Yes using the arrow keys to delete arrays or press the ESC key to exit. 

3.5 Manage Spares 

This option allows the user to assign or unassign global or dedicated spares. 

Note: To assign a physical disk as a Global Spare, it must not be part of any Array. 

 Assign Global Spares 

1. From the RaidXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Physical Disk Management, then press Enter. 

2. Select Physical Disk Operations using the arrow keys, then press Enter. 

3. Select Select Physical Disk using the arrow keys, then press Enter. 

4. Select Assign Global Hot Spare using the arrow keys, then press Enter. 

5. Review the warning message, if you want to proceed, use the arrow keys to select Yes, or 

press ESC or No, to exit. 

 Assign Dedicated Spares 

Note:  Dedicated spares can only be assigned to redundant arrays and must the same size or 

larger than the other members of the redundant array. 
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1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Array Management, then press Enter.  

2. Select Manage Array Properties using the arrow keys, then press Enter. 

3. Select Select Array using the arrow keys. 

• Select the desired array (must be a redundant array) from the drop-down menu, 

then press Enter. 

4. Select Manage Dedicated Hot Spares using the arrow keys, then press Enter. 

5. Select the disks to assign as dedicated spares. 

a. Select the disk using the arrow keys to highlight the disk and press the space bar or 

Enter to select it. 

b. Select Add Hot Spare Physical Disk using the arrow keys, then press Enter. 

c. At the warning message, press the space bar or Enter to Confirm. 

d. Select Yes using the arrow keys, then press Enter or press the ESC key to exit adding 

the Dedicated Spare. 

 Unassign Spares 

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Physical Disk Management, then press Enter. 

2. Select Select Physical Disk Operations using the arrow keys, then press Enter. 

3. Select Select Physical Disk using the arrow keys, then press Enter. 

4. From the drop-down menu, use the arrow keys to select the Global / Dedicated Spare, 

then press Enter. 

5. Select Unassign Hot Spare using the arrow keys, then press Enter. 

6. Review the warning message, if you want to proceed select Yes, then press Enter or press 

the ESC key to exit. 

3.6 View Controller Details 

This option will display the details about of the controllers. Nothing can be changed using this 

menu option; it is for informational purposes only.  

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Controller Management, then press Enter. 

2. Select Select View Controller Information using the arrow keys, then press Enter. 

3. Select Select Controller using the arrow keys, then press Enter. 

4. From the drop-down menu, select the desired controller, then press Enter. Information 

about the controller is displayed below the Select Controller header: 

• PCI ID 

• Controller Physical Disk Count 
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• Total Physical Disk Count 

• Total Array Count 

• UEFI Driver Version 

• Firmware Properties/Firmware Build Time 

5. To view another controller, press Enter and from the drop-down menu, select a different 

controller, then press Enter. 

6. Press ESC to exit to the Main Menu. 

3.7 View Disk Details 

This option allows the user to view details about the physical disk(s). Nothing can be changed 

using this menu option; it is for informational purposes only.  

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to highlight 

Physical Disk Management, then press Enter. 

2. Select View Physical Disk Properties using the arrow keys, then press Enter. 

3. Select Select Physical Disk using the arrow keys, then press Enter. 

4. From the drop-down menu, select the physical disk you want more information about, then 

press Enter. 

5. Information about the physical disk is displayed below the Select Physical Disk header: 

• Unique Disk ID 

• State 

• Size 

• Smart Status 

• Revision 

• Drive Type 

• Maximum Free Space 

• Used Space 

• Disk Protocol 

• Disk Speed 

• Associated Array, if part of one 

• Serial Number 

• Model Number  

6. To view another physical disk, press Enter and from the drop-down menu, select a 

different physical disk, then press Enter. 

7. Press ESC to exit to the Main Menu. 
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3.8 View Array Details 

This option will display the details of an array. Nothing can be changed using this menu option; it 

is for informational purposes only.  

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Array Management, then press Enter. 

2. Select Select Manage Array Properties using the arrow keys, then press Enter. 

3. Select Select Array using the arrow keys, then press Enter. 

4. From the drop-down menu, select the desired array, then press Enter. 

5. Select View Associated Physical Disks using the arrow keys, then press Enter 

6. Press the space bar to select one of the members of the Array 

7. Select View Physical Disk Properties using the arrow keys, then press Enter 

8. Information about the array is displayed below the Select Array header: 

• Array number 

• RAID level 

• State (see Table 6) 

• Size 

• Cache Tag Size 

• Cache settings 

• Associated physical disks 

9. To view another array, press ESC twice and perform steps 2 through 8 again. 

10. Press ESC to exit to the Main Menu. 

3.9 Rescan All Channels 

This option allows the user to rescan all channels to detect new or removed disks and arrays. It 

rereads the configuration information from each disk. 

Sometimes when a disk is offline, it can be brought online through a rescan. 

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select 

Controller Management, then press Enter. 

2. Select Rescan Disks using the arrow keys, then press Enter. 

• After a rescan completes, all of the physical disks are displayed. 

3. Select OK using the arrow keys, then press Enter.  
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Chapter 4 AMD RAIDXpert2 Graphical User 

Interface (GUI) 

4.1 Start RAIDXpert2 

The RAIDXpert2 graphical user interface (GUI) is a Desktop Application tool designed and 

packaged to be a UWP compliant package, available from the Microsoft Store. It reads and writes 

to the internal RAID drivers, which communicate with the AMD RAID arrays and physical 

devices. Also available, is a version that is based off the Desktop application but is not UWP 

compliant. 

Open the Windows menu and search for AMD RAIDXpert2 or the desktop shortcut. 

 Desktop Shortcut Access 

4.1.1.1 Signing in Using the RAIDXpert2 Desktop Shortcut 

Open the Windows menu and search for AMD RAIDXpert2, click to open or make a desktop 

shortcut, or pin to the taskbar. 

4.1.1.2 Help and About Windows 

To view the software version and build number for the GUI, select About at the Help menu. The 

AMD RAIDXpert2 Driver Version and GUI Version are displayed.  

For reference help, select Help > User Guide. A PDF version of this document is displayed. A 

PDF reader program is needed to view it. 

For further customer support, click Help > Support for the AMD Drivers and Support page, or 

contact your system supplier or motherboard vendor. 

4.2 Reviewing the RAIDXpert2 GUI 

 The Array View Section of the Array Status Window 

4.2.1.1 Elements of the Array View Section 

The Array View section presents a graphical view of array properties. Table 15 provides 

information about the elements of the Array View section (see Error! Reference source not 

found. on page Error! Bookmark not defined.). 
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Table 15. Elements of the Array View Section, Array Status Window 

Element Description 

Controller Name The RAIDXpert2 controller for the arrays displayed below it. 

Array The number assigned to an array. 

Array name The name assigned to an array. 

RAID Level The RAID level of the array. 

Disk Number The number assigned to disks in an array. 

Disk Manufacturer The manufacturer of disks in an array. 

Disk Model Number The model number of the disks in an array. 

 

Figure 1.  Array Status Window 

 The Disk List Section of the Array Status Window 

4.2.2.1 Elements of the Disk List Section 
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The Disk List section provides information about all disks assigned or available to arrays. Table 

16 provides information about the elements of the Disk List section. 

Table 16. Elements of the Disk List Section, Array Status Window 

Element Description 

Disk Controller and disk number. 

State State of the disk (Online, Offline, SMART Error). 

Type Disk type (Disk, Legacy, New). 

Port Type Negotiated Speed (not the speed of the port type and SATA NCQ or NVMe 

Capacity Disk capacity:  

1 MB = 1,000,000 bytes 

1 GB = 1,000,000,000 bytes 

Note: Because the ATA storage industry has standardized the meanings of 

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 

reports the same units 

Space Available Total amount of space unused on the disk. 

Largest Available Largest contiguous unused space on the disk. 

Global Spare (GS) Indicates if the disk is assigned as a global spare. 

Users Number of arrays that this disk is a member of. 

Model Disk manufacturer’s model number. 

Serial No. Disk manufacturer’s serial number. 

Firmware Disk manufacturer’s firmware version. 

 

If a disk is missing from the Disk List, the most likely causes are: 

• A loose cable. Make sure that all disk cables are connected, then perform a rescan. 

• A disk that is not fully seated in its bay or slot. Make sure that the disk is inserted 

completely in its bay or slot, then perform a rescan. 



  

53987 Rev. 3.20 September 2023 AMD RAID User Guide 

 

Chapter 4 AMD RAIDXpert2 Graphical User Interface (GUI) 47 

 

[Public] 

 The Array List Section of the Array Status Window 

4.2.3.1 Elements of the Array List Section 

The Array List section provides information about the arrays. Table 17 provides information about 

the elements of the Array List section. 

Table 17. Elements of the Array List Section, Array Status Window 

Element Description 

Device The array number. 

OS Name Corresponds to the Disk number in Windows Disk Management. 

System If yes, it is your boot array, otherwise it is not a boot critical array. 

Partition  

Drive letter that was assigned to this array during the partition process. (A 

blank space appears if the array has not been partitioned.) 

Note: If a dynamic volume is created on an array, RAIDXpert2 cannot 

retrieve the volume’s drive letter. 

Array Name User-created name for the array. 

Type The RAID level (RAID type) or LEGACY. 

Total Capacity 

Total capacity:  

1 MB = 1,000,000 bytes 

1 GB = 1,000,000,000 bytes 

Note: The ATA storage industry standardizes MB as 1,000,000 bytes and 

GB as 1,000,000,000 bytes, so RAIDXpert2 reports the same units. 

State State of the array (NORMAL, CRITICAL, OFFLINE). 

Task 
Task type, if in progress (TRANSFORM, CHECK, CHECK_BITMAP, 

CREATE, RESTORE, ZERO, SECURE_ERASE). 

Task State 
The state of the task (STARTED, PAUSED, COMPLETED); the progress 

of the task is given in the Array View section. 

Process  Percent given of a given task. 

Pri Task priority if a task is in progress. 
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Table 17. Elements of the Array List Section, Array Status Window (continued) 

Element Description 

Scan Background Array Scan enabled? (Yes/No). 

Cache 
Current cache setting (NC = No Cache, R = Read Ahead Cache, W = Write 

Back Cache, RW = Read/Write Cache). 

Cache Tag size 
Any Array with only HDD/SSD will have default CTS of 64k 

Any Array with NVMe/HDD/SSD will have default CTS of 256k 

Trim No: Array does not support Trim. Yes: Array supports Trim. 

Dedicated Spare If assigned, the number of dedicated spares assigned to array.  
 

 The Event View Section of the Array Status Window 

4.2.4.1 Elements of the Event View Section 

The Event View section is an optional-view section. It can be displayed or hidden by selecting 

View > Event View. 

The information in the Event View is linked to the View Log. The View Log displays user-

initiated tasks or actions, and system-generated notifications and events. The View Log can be 

accesses by selecting View > Log. 

The Event View provides information about the events. Table 18, on page 49, provides 

information about the elements of the Event View section. 
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Table 18. Elements of the Event View Section, Array Status Window 

Element Description 

# The number of the event. 

Date The date and time at which the event occurred. 

Event The RAIDXpert2 Asynchronous Event Notification (AEN) number of the event. 

Priority The notification priority of the event: Low, Informational, Warning, Critical, or Fatal. 

Text A brief description of the event. 

 Array and Disk Commands 

The Array and Disk menus of the Array Status window contain lists of commands. The commands 

allow the system user to initiate or modify array- and disk-related tasks.  

Not all commands are available for an array or for the system. Availability depends on:  

• The tasks that can be performed with the system’s license level. 

• The RAID level of an array. For example, a Consistency Check can be performed only on 

arrays at a redundant RAID level. 

• The remaining capacity of the disk drives. For example, if a system has three disk drives 

and large arrays have used all of the capacity on two of the disks, only non-redundant 

Volume arrays can be created on the remaining disk. Certain commands are not available 

with a non-redundant array. 

Table 19 provides page numbers for each command. 

Table 19. Disk Menu Commands 

Disk Commands See Detailed Information on this Page 

Rescan page 50 

Initialize page 50 

Clear Metadata Page 50 

Properties page 51 

Options page 51 
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4.3 Working with Disks 

 Rescan Disks 

The Rescan Command Performs the Following Actions:  

• Rescans the SATA channels that search for new, legacy, or removed disks. 

• Rereads the configuration information from each disk.  

When a disk is offline, it might be brought online by using a rescan. A rescan also stops and then 

automatically resumes all tasks. 

To rescan disks, select Rescan at the Disk menu. 

 Initialize Disks 

When a disk is initialized, RAIDXpert2 configuration information (metadata) is written to the 

disks. If a disk is new and has not been used before, or if it is a legacy disk, it must be initialized 

before it can be used in a RAIDXpert2 array. After a disk is initialized, it appears as Disk in the 

Disk List. 

If all the disks contain metadata, the Initialized button is deactivated (greyed out). 

Note: All new disks and legacy disks will have an associated array. You must delete the array in 

order to initialize the disk. 

4.3.2.1 To Initialize Disks 

1. At the Disk menu, select Initialize. The Initialize Disk window displays. 

2. Select the disk(s) to be initialized, by selecting the box next to the disk(s). 

3. Click Initialize Selected. 

 Clear Metadata Description 

When a device has Clear Metadata applied to it, the RAIDXpert2 metadata is removed and the 

device becomes a New/Legacy device. 

If the device is part of an Array or is a New/Legacy device, it will not be available to be selected. 

Also, if there aren’t any devices that are empty, the Clear Metadata button is deactivated (greyed 

out). The device will no longer be useable in AMD RAIDXpert2 until it is initialized. 

4.3.3.1 To Clear Metadata Steps 

1. At the Disk Menu, select Clear Metadata. The Clear Metadata window displays. 

2. Select the device(s) to be initialized, by selecting the box next to the device(s). 

3. Click Clear Metadata. 
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 Change Cache Properties for Disks 

The Read Ahead and Write Back Cache properties can be changed if the disks support this option. 

The default settings are:  

• Read Ahead: enabled. 

• Write Back Cache: enabled. 

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being 

corrupted if the system experiences a power interruption or unexpected shutdown. 

Note: A disk’s cache setting cannot be changed if a task is active for the array. The cache settings 

are enabled when the task is finished. 

Note: As default setting NVMe Physical disk Read ahead and Write Back cache is always 

disabled. User cannot enable the setting as it may impact the operational performance of the 

NVMe disk. 

4.3.4.1 Change Disk Caching Properties 

1. At the Disk menu, select Properties.  

2. The Properties window opens.  

3. Select the disks you want to change the properties of. 

4. Click Enable or Disable for the desired settings.  

 Options 

Spare disks allow an array to be rebuilt when a disk fails. Global spares can be used in any array, 

while dedicated spares are assigned to a specific array. 

4.3.5.1 Assign a Disk as a Dedicated or Global Spare 

1. Select a disk in the Disk List section. 

2. Select Options at the Disk menu. Options for Disk Device displays in the Disk List panel.  

3. Perform one of the following actions: 

• To use the disk as a dedicated spare, select Assign as Dedicated Spare. 

Note: The capacity of a dedicated spare must be equal to or larger than the capacity of the 

smallest disk in the array. 

• Select Assign as Global Spare to use the disk as a global spare. 

4. Click Confirm. 
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4.4 Working with Arrays 

 Create and Format Arrays 

RAIDXpert2 allows the partitioning and creation of as many as eight arrays across the system’s 

disks. Portions of disks can be used to create arrays, while other arrays use different portions of 

the same disks.  

Table 20. Array Menu Commands 

Array Commands See Detailed Information on this Page 

Create page 53 

Name page 54 

Transform  page 55 

Check Consistency page 61 

Background Array Scan page 62 

Modify Cache Settings page 59 
 

Table 20. Array Menu Commands (continued) 

Array Commands See Detailed Information on this Page 

Task page 60 

Name page 54 

Hide page 63 

Identify Array page 47 

Prepare to Remove page 62 

Remove Spares page 63 

Delete page 58 

Delete Multiple Arrays page 58 

Secure Erase page 63 

 

4.4.1.1 Before You Begin 

Review the issues and recommendations indicated in Table 21. 



  

53987 Rev. 3.20 September 2023 AMD RAID User Guide 

 

Chapter 4 AMD RAIDXpert2 Graphical User Interface (GUI) 53 

 

[Public] 

Table 21. Creating Arrays: Issues and Recommendations 

Issues Recommendations 

Access to arrays Creation of arrays, even redundant arrays, allows users immediate access to 

the arrays (unless the Zero Create option is used during the Create process). 

Array numbers Array numbers are valid only for a given boot and can be different in the BIOS 

Configuration Utility and RAIDXpert2. If a permanent label is required, use 

the Array Naming feature, Name Arrays (Section 4.4.2, page 54). 

Array size The array size of the new array is limited to 2.199 TB on some versions of 

Windows and Linux. Refer to the operating system documentation for details 

on maximum array sizes. 

Number of arrays In some circumstances, more than eight arrays are possible. They might appear 

to function properly but are not supported by AMD RAID. 

System reboot When the system reboots, the creation process continues where it left off. 

4.4.1.2 Create an Array 

4.4.1.2.1 Select an Array and Cache 

1. Select Create at the Array menu. 

2. Select the disk(s) to include in the array by checking the box next to the desired disk(s) in 

the Select Active Disks: field. 

Note: Click All to select all disks, or click Unused to select disks that are not currently used in an 

array. Maximum of 8 NVMe/HDD/SSD disks can be part of array. if more than 8 disks, the 

Create button will be grayed out or unselectable. 

3. Enter a name for the array in the Array Name: field. 

Note: The following characters are not allowed in an array name. 

( ) ^ , | = “  ” . [ ] 

4. Select an array type at the Array Type: drop-down menu.  

5. Select an option at the Organized As: drop-down menu. 

Note: The Organized As: drop-down menu only displays options for advanced management of a 

RAID10 configuration if you selected RAID10. 

6. Enter the capacity in the Capacity: field. The maximum available capacity changes with:  

• The disks that are selected. 

• The RAID level of the array. 



  

AMD RAID User Guide 53987 Rev. 3.20 September 2023 

 

54 AMD RAIDXpert2 Graphical User Interface (GUI)  Chapter 4 

 

[Public] 

7. Select a cache option at the Cache Options: drop-down menu. (The default is Read and 

Write Back Cache.) 

8. Cache Tag Size will default to a setting based off of the disks that are selected.  All 

HDD/SSD, default will be 64k. All NVMe or a mix of NVMe/HDD/SSD will default to 

256k.  The user should not change from the default settings. 

9. Check Background Array Scan to enable background array scanning. (A background 

array scan checks sectors of the disks in an array for potential problems. A background 

array scan runs continuously, until the user stops it by accessing Array > Background 

Array Scan > Stop.) 

Note: Please refer to Table 14 on page 36 for Default Cache Tag Size. 

Note: See Section 4.4.11, Scan an Array in the Background, on page 62, for details. 

10. Check Skip Initialize to skip initialization. 

CAUTION: Creating a redundant array with Skip Initialization selected can result in data 

corruption. 

11. Check Leave Existing Data Intact if an array is lost or deleted, and the user immediately 

creates a replacement array of the same characteristics. This leaves the data on the disks of 

the lost or deleted array untouched when the replacement array is created. See Table 39, on 

page 90, for additional information. 

12. Check Zero Create to write zeros on the created array. If Zero Create is used, the array is 

not immediately available. (The array is hidden from the operating system during the 

Create process.) 

13. Click Create to create the array. 

4.4.1.3 Partition and Format an Array 

Each operating system has different names and paths for partitioning and formatting arrays and as 

such are outside the scope of this document. For more information, see your operating system’s 

user documentation. 

 Name Arrays 

Naming an array can be useful when creating backups. It makes an array easy to identify in a list. 

1. In the Array View section, select the array to name. 

2. At the Array menu, select Name. The Array Name window displays. 

3. Type the desired name in the blank field.  

Note: The following characters are not allowed in an array name. 

( ) ^ , | = “  ” . [ ] 
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4. Click OK. The array name appears in the Array List and in the BIOS Configuration Utility 

(only 17 characters of the name are displayed in the BIOS Configuration Utility). 

 Transform Arrays  

With the Transform task, an array can be:  

• Transformed from one RAID level to almost any other RAID level. This function is also 

referred to as Online RAID Level Migration (ORLM).  

• Expanded dynamically, even under I/O load, by adding disks to the array to increase array 

capacity. This function is also referred to as Online Capacity Expansion (OCE).  

4.4.3.1 Before You Begin 

Review the issues and recommendations indicated in Table 22. 

Table 22. Transforming Arrays: Issues and Recommendations 

Issues Recommendations 

Array size An array cannot be transformed to a smaller-sized array. The transformed 

array must be the same size as or larger than the original array. 

Array size limits The array size of the transformed array is limited to 2.199 TB on some 

versions of the Windows and Linux operating systems. Refer to the 

operating system documentation for details on maximum array sizes. 

Disk failure during a 

Transform 

If a disk fails while the Transform task is in progress, no data is lost if the 

source and destination RAID levels are redundant. If a spare has been 
assigned to the destination array, a fail-over task starts as soon as the 

Transform completes (if the spare is available after the Transform). 

Multiple arrays If there are multiple arrays, it might not be possible to transform some of the 

arrays to a larger size. If, in the future, an array needs to be expanded in 

size, it is best to configure the available space as a single array. 

Task control 

commands 

When using task control commands, a Transform task can only be paused or 

resumed but not removed. To end a Transform task, pause and delete it. 

Note: If a task is paused, then deleted, the array is deleted. Deleting a task is 

the same as deleting an array. Data loss occurs when a task is deleted. Back 

up data before deleting a task involving Transform or Restore. 

System reboot 

during a Transform 

If the system reboots during a Transform, the Transform continues where it 

left off. 
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4.4.3.2 Transform an Array 

1. In the Array View section, select the array to transform. 

2. At the Array menu, select Transform. 

Note: If the system window is not wide enough, only the Destination View is displayed. 

3. Select all the desired disks for the array (including disks that might be already in the array) 

by selecting the box next to the drive in the Disk List section. 

Note: Click Same to select all disks currently used in the array, All to select all disks, or 

Unused to select disks that are not currently used in an array. 

4. Select the RAID level to be transformed at the Array Type: drop-down menu. 

5. Select an option at the Organized As: drop-down menu. 

Note: The Organized As: drop-down menu only displays options for advanced management 

of a RAID10 configuration if you selected RAID10. 

6. Expand the array by entering the size of the new array in the Capacity: field. The 

maximum available capacity changes with:  

• The disks that are selected. 

• The RAID level of the array. 

Note: If a Transform is not possible, the Commit option is not enabled. A typical reason 

preventing a Transform is insufficient available space on the disks. 

7. Click Commit. 

Note: Unless the transformation is instantaneous, the Array Status window updates to show the 

source and destination arrays, along with the progress of the transformation. 

4.4.3.3 Access Additional Space 

After an array has been transformed to a larger size, use the operating system tools to access the 

additional space.  

There are several possible methods for expanding the existing file system on an array that has been 

transformed to a larger size: 

• Microsoft provides a command prompt utility called Diskpart.exe that can expand any 

NTFS file system without requiring a reboot. The Diskpart.exe utility version to use 

depends on the version of Windows being run. The Diskpart.exe utility can be found on 

the CD that comes with some versions of Windows, or at the Microsoft website 

(http://www.microsoft.com) for others. Use the correct version for the operating system. 

• For arrays formatted with FAT32, use a third-party application, such as PartitionMagic 

from PowerQuest Corporation. 

http://www.microsoft.com/
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 Restore (Rebuild) Arrays 

With the Restore task, a redundant-type array whose state has changed to Critical can be restored 

(rebuilt) in one of two ways: 

• By assigning a dedicated spare to the array.  

• By creating a global spare or by using an existing global spare. (An existing global spare 

automatically starts restoring a redundant-type array after the array’s state changes to 

Critical.) 

An array in an Offline state cannot be restored. This means that non-redundant arrays (Volume, 

RAID0) cannot be restored: when a single disk in a non-redundant array fails, the array state 

changes to Offline.  

Note: If a Critical redundant array that is being restored loses a second disk (RAID1), or loses a 

second disk in the same mirror set (RAID10), the Restore task fails. The array must be re-

created from backup storage data. 

4.4.4.1 Before You Begin 

• Make sure that the disk chosen as the dedicated spare or global spare has sufficient 

available capacity to restore the array. The capacity of the spare disk must be equal to or 

larger than the capacity of the smallest disk in the critical array. 

• Know how to create a global or dedicated spare. See Section 4.4.12, Add or Remove 

Dedicated Spares, on page 62 or Section 4.4.13, Add or Remove Global Spares, on 

page 63. 

4.4.4.2 Restore a Critical Array 

1. In the Array View section, select the critical array. 

2. At the Disk List section, double click on a disk. 

3. At the Disk menu, select Options. Options for Disk Device displays in the Disk List 

panel. 

4. Perform one of the following actions: 

• To use the disk as a dedicated spare, select Assign as Dedicated Spare. 

• To use the disk as a global spare, select Assign as Global Spare. 

5. Click Confirm. 
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 Prepare to Physically Remove an Array 

4.4.5.1 Physically Remove an Array 

CAUTION: Prior to removing an array, remove its drive letter (Windows) or unmount the array 

(Linux). 

1. Select the array to remove in the Array View section. 

2. Select Prepare to Remove at the Array menu.  

3. Click Yes at the Prepare to Remove window. The array and all associated disks disappear 

from the Array Status window. 

4. Remove the first disk from the system.  

5. Click Cancel when the Drive Removed window displays.  

6. Remove the remaining disks in the array. 

7. When all disks in the array are removed from the system, select Rescan at the Disk menu. 

4.4.5.2 Array Migration 

The disks in an array, after being removed from one system with a RAIDXpert2 controller, can be 

migrated to another system with a RAIDXpert2 controller. The disks and array(s) appear in the 

second system, in Disk Management, the BIOS Configuration Utility, and RAIDXpert2, as normal 

RAIDXpert2 disks and array(s). 

If the disks from a RAIDXpert2 system are migrated to a non-RAIDXpert2 Windows-based 

system, the disks appear in Disk Management of the second system as healthy, unknown 

partitions. To use the disks, use Disk Management to delete the RAIDXpert2-created partitions 

and to create Windows partitions on the disks. 

CAUTION: All data contained in a RAIDXpert2 array are lost if the RAIDXpert2 disks of the 

array are migrated to a non-RAIDXpert2 system. 

 Delete Arrays 

CAUTION: Deleting an array permanently destroys all data that is on the array. This action 

cannot be undone, and it is very unlikely the data can be recovered. 

4.4.6.1 Before You Begin 

Review the issues and recommendations indicated in Table 23. 
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Table 23. Deleting Arrays: Issues and Recommendations 

Issue Recommendation 

Drive letters or 

partitions 

Remove drive letters or partitions from the array using procedures in your 

operating system. Each operating system has different names and paths for 

removing drive letters or partitions and as such are outside the scope of this 
document. For more information, see your operating system’s user 

documentation. 

Operating system 

impact on arrays 

If the array is not being used by the operating system, the array can be 

deleted at any time, even while tasks are running on the array.  

If the array is being used by the operating system, the array cannot be 

deleted. Therefore, a RAIDXpert2 bootable array cannot be deleted in 
RAIDXpert2. A RAIDXpert2 bootable array can only be deleted in the 

BIOS Configuration Utility. 

4.4.6.2 Delete an Array 

1. In the Array Status window, select the array to delete. 

2. At the Array menu, select Delete. A window opens, warning about deleting the array. 

3. Click Yes. The array disappears from the Array View section. 

Note: Also see Section 5.5, Delete Arrays: rcadm --delete, on page 73. 

4.4.6.3 Delete Multiple Arrays 

1. Select Delete Multiple Arrays at the Array menu. 

2. Select (check mark) the arrays you want to delete. The Select All button can also be used. 

3. Click the Delete Button. A window opens, warning about deleting the array(s). 

4. Click Yes.  The array(s) will disappear from the Array View Section. 

4.4.6.4 Recreate a Deleted Array 

If an array is deleted, it might be possible to recreate the array. See Table 39. Recreate a Deleted 

Array, on page 90. 

 Cache Settings for Arrays 

Table 24 provides information about the four array-caching options available. 
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Table 24. Cache Array Options 

Option Description 

No Cache I/O requests are translated and passed to the disks without keeping a 

cached copy of the data available for future requests 

Read Cache Data reads are cached, if appropriate. This option performs sequential 

Read Ahead, when necessary 

Write Back Cache Data writes are cached. This setting is intended for advanced users who 

understand the implications of Write Back caching 

Read + Write Back 

Cache (default setting) 

Both Read and Write Back Cache options can be selected 

Note: Cache options cannot be changed while a task is active on the array. They can be changed 

at any other time, including while I/O is running. 

4.4.7.1 Change Cache Settings 

1. Select the array on which to change caching options in the Array View section. 

2. Select Modify Cache Settings at the Array menu. 

3. Choose No Cache, Read Cache, Write Back Cache, or Read + Write Back Cache. The 

new cache setting displays in the Array List Cache information. 

4. Select Rescan at the Disk Menu. 

 Change the Priority Level of a Task 

The task priority command allows the user to speed up or slow down tasks performed on arrays. 

To decrease the amount of time for a task to complete, set the task priority higher (10 is highest). 

Note: A task priority can only be changed after a task is running on the array.  

4.4.8.1 Change a Task Priority 

1. Select the array on which tasks are being performed in the Array View section. 

2. Select Task and select Priority at the Array menu. 

3. At the Task Priority window, change the task priority by moving the slide one way or the 

other.  

4. Click OK. 
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 Interrupt, Cancel, or Resume a Task 

Task control commands allow users to pause, resume, or cancel (remove) tasks being performed 

on arrays. Full task control can be used on Create, Consistency Check, and Check Bitmap tasks. 

On Restores with dedicated or global spares, the task can be removed, but the array returns to the 

Critical state. 

Note: Task control can be used only when a task is running on an array. 

4.4.9.1 Interrupt, Cancel, or Resume a Task 

1. In the Array View section, select the array on which a task is being performed. 

2. At the Array menu, click Task and select one of the following: 

• Pause to interrupt the task. 

• Remove to cancel the task. 

• Resume to interrupt the task. 

 Check for Consistency 

For redundant-type arrays only, the Consistency Check task is available at the Array menu. When 

this task is selected it starts the process of verifying that the mirror drive consistency for fault-

tolerant disks is correct. If inconsistent areas are found, they are corrected during this process. 

Having consistent arrays is very important. If an array is inconsistent and a drive fails, data is lost. 

RAIDXpert2 is designed to maintain consistent arrays, but it is good practice to run frequent 

consistency checks. 

When a redundant array is created using Create, and Skip Initialize is not checked (default), a 

Consistency Check is performed automatically. Consistency Checks that run during a Create task 

can be removed (by highlighting the array and selecting Task > Remove), but the array created is 

not redundant. Arrays are not protected unless a Consistency Check runs end-to-end. 

After a Consistency Check is started, adjust the priority of its task relative to user I/O activity. Use 

the Task Priority option (see Section 4.4.8, Change the Priority Level of a Task, on page 60). 

4.4.10.1 Before you Begin 

• The Consistency Check command can be started at any time on a redundant-type array, as 

long as another task is not running on the array. 

• The Consistency Check command can be started while under I/O load. 

• If the array state is Critical, the Consistency Check fails. 

• To estimate remaining time for a Consistency Check, note the percentage of the task that 

is completed (hours:minutes:seconds). Details are displayed by the array in the Array 

View section of the Array Status window. 
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4.4.10.2 Manually start a Consistency Check 

1. Select the array on which to run the Consistency Check in the Array View section. 

2. Select Check Consistency at the Array menu. 

3. Click Start. 

4.4.10.3 Manually stop a Consistency Check 

1. Select the array on which to stop the Consistency Check in the Array View section. 

2. Select Check Consistency at the Array menu. 

3. Click Stop. 

 Scan an Array in the Background 

A Background Array Scan task performs a continuous background read operation of an array, 

accessing at least one copy of every block of the array from beginning to end.  

The user manually starts a Background Array Scan. It runs continuously until the user stops it. 

Although a Background Array Scan can run while an array is engaged in other tasks, it is 

recommended that it runs while the array is idle (that is, when there is no I/O to or from the array). 

4.4.11.1 Enable or Disable a Background Array Scan 

1. Select the array on which to run the Background Array Scan in the Array View section. 

2. Select Background Array Scan at the Array menu. 

3. Enable or disable the Background Array Scan. 

• Select Start to enable a Background Array Scan. 

• Select Stop to disable a Background Array Scan. 

Note: A Background Array Scan can also be enabled for an array when it is created. 

 Add or Remove Dedicated Spares 

If a dedicated spare is added, make sure there is adequate space on the dedicated spare.  

4.4.12.1 Add a Dedicated Spare 

1. Select the array on which to assign a dedicated spare in the Array View section. 

2. Double-click on the disk chosen as the dedicated spare in the Disk List section. 

3. Select Options at the Disk menu.  

4. Select Assign as Dedicated Spare, then click Confirm. 
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4.4.12.2 Remove a Dedicated Spare Assignment 

1. Select the array from which to remove a dedicated spare in the Array View section. 

2. Select Options at the Disk menu.  

3. Select Remove as Dedicated Spare, then click Confirm. 

TIP: For additional information see Section 2.10, Sparing Options: Disks and Arrays, on page 30. 

 Add or Remove Global Spares 

If a global spare is being added, make sure there is adequate space on the global spare.  

4.4.13.1 Add a Global Spare 

1. Select the disk chosen as the global spare in the Disk List section. 

2. Select Options at the Disk menu.  

3. Select Assign as Global Spare, then click Confirm. 

4.4.13.2 Remove a Global Spare 

1. Select the disk to be removed as the global spare in the Disk List section.  

2. Select Options at the Disk menu.  

3. Select Remove as Global Spare, then click Confirm. 

 Hide an Array 

Hide allows the user to hide the array from the operating system. 

4.4.14.1 Hide an Array 

1. Select the array to hide in the Array View section. 

2. Select Hide at the Array menu. The array will disappear from the Array View. 

Note: If the array is currently hidden, select Array > Un-hide to display it. 

 Secure Erase 

Secure Erase is used for erasing all data on an array and ensuring that it will be unrecoverable, 

even with advanced data recovery techniques. 

Data is Securely Erased By: 

• Hiding the array from the OS 

• Writing over each region of the disk with 3 patterns (0xAA, 0x55, and random) 

• Using a 4th pass with all zeros to ensure that a RAID1 will be consistent 



  

AMD RAID User Guide 53987 Rev. 3.20 September 2023 

 

64 AMD RAIDXpert2 Graphical User Interface (GUI)  Chapter 4 

 

[Public] 

After secure erase is complete, a user can manually delete the array or reuse it. If the user chooses 

to reuse it, it must be unhidden using the procedure in Section 4.4.14, Hide an Array, on page 63. 

CAUTION: When an array is securely erased, the data on the array is lost. 

4.4.15.1 Securely Erasing an Array 

1. Select the array to erase in the Array View section. 

2. Select Secure Erase at the Array menu, then click OK. 

4.5 Working with Views 

The View menu allows the user to:  

• Refresh the display 

• Display the event view 

• Display the Application log 

• View Controllers 

• Theme – Dark, light 

• Icon Size – Small, Large 

• Font Size – Small, Normal, Large 

 Display or Hide Controller Event Log Panel 

To display or hide the Controller Event Log, select Event View at the View menu. When the 

Controller Event Log panel displays, a checkmark is displayed by the Event View option at the 

View menu. 

 Log Window 

The [system name]: View Log window displays all the messages generated by RAIDXpert2. All 

messages are logged, not just the ones enabled at Options > Notification.  

All messages received from the RAIDXpert2 driver are sent to a message log file. If desired, 

change the name of this file in the Notification window. 

By default, notification events in Windows-based systems are saved to:  
%Program Files%\RAIDXpert2\rc_service.log  

Notification events in Linux-based systems are saved to: /var/log/rc_service.log 

Select Log to view the RAIDXpert2 messages at the View menu. 
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 Refresh the Display 

Select Refresh at the View menu to refresh the display. 

 View Controllers 

1. Select View Controllers in the View menu. A window lists the system Controller List. 

Note: The list includes Controller Number, Type, Serial Number, Port Count, PCI Vendor 

ID, PCI Device ID, PCI SubVendor ID, PCI SubDevice ID, Bus, Slot, Function. 

2. Click OK to close the window. 

4.6 Working with Options 

 Event Notifications 

The Event View section of the Array Status window displays the priority listing. The event log 

priority levels, in ascending order, are indicated in Table 25. 

Table 25. Event Log Priority Levels 

Event Priority Description 

Low Displays messages for normal system operations. (This event is not displayed unless 

requested by the user.) 

Informational Displays information that might be useful to know. 

Warning System user should be informed about this event, but probably does not need to take 

action. 

Critical The system user must be informed about this event and should take action. 

Fatal The RAIDXpert2 driver is fatally damaged and the RAID subsystem has shut down. 

4.7 Add Spares Using a RAIDABLE Array 

Note: RAIDABLE array is formerly known as RAID Ready array. 

1. Install a new disk. After a rescan, a pop-up window opens. 

Note: To create a redundant RAID1 array, the new disk must be the same size or greater than 

the RAIDABLE disk. 

2. Select the new disk in the Select a Disk section. 
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3. Select the desired option in the Choose a Task section. 

Note: Selecting any option first initializes the disk before the selected task is started. 

a. Backup Array: This option creates a backup of the RAIDABLE array on the new 

disk. 

b. Transform Array: This option allows the user to either add space to the RAIDABLE 

array or create a redundant array. 

c. Initialize Disk for AMD RAID: This option allows the disk to be used when creating 

arrays. 

d. Make disk a Global Spare: This option assigns the new disk as a global spare. 

4. In the Select a Source/Destination section: 

a. Select the Source RAIDABLE Array from the drop-down menu. 

b. Select the Destination Array Type from the drop-down menu. 

Note: The Destination Array Type option is only available when either the Backup Array 

task or Transform Array task is selected. Only valid array types for the number of 

disks inserted will be displayed. For example, if one new disk is inserted, only RAID0 

or RAID1 will display in the drop-down menu. 

5. Click Confirm. 

If either the Backup Array task or Transform Array task is selected, a Task Progress dialog 

box opens. To hide the dialog box while the task is executing, click Close. 
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Chapter 5 rcadm Command Line Interface 

Tool 

5.1 What is rcadm? 

The rcadm program is a command line interface (CLI) tool for managing RAIDXpert2 in the 

Windows, Linux, or EFI operating system. See Section 5.8, on page 74, for rcadm.efi Information. 

The rcadm program initiates RAIDXpert2 operations, such as:  

• Manage RAIDXpert2, arrays and disks (see Section 5.2, Manage Arrays and Disks: rcadm 

--manage, on page 68). 

• Create new arrays (see Section 5.4, Create New Arrays: rcadm --create, on page 73). 

• Delete arrays (see Section 5.5, Delete Arrays: rcadm --delete, on page 73). 

• Transform arrays (see Section 5.6, Transform Arrays: rcadm --transform , on page 74). 

• Follow or monitor arrays and disks (see Section 5.7, Follow or Monitor Arrays and Disks: 

rcadm --follow, on page 74). 

• Information on drive and array states. 

The rcadm program has five primary modes, with most primary modes having additional optional 

arguments. The five modes of operation are indicated in Table 39. 

Table 26. Modes for the rcadm Program 

Mode Usage 

Manage Uses the rcadm --manage command to manage and query RAIDXpert2, 

arrays, and disks. 

Create Uses the rcadm --create command to create a new array. 

Delete Uses the rcadm --delete command to delete arrays. 

Transform Uses the rcadm --transform command to transform an array.  

Follow Uses the rcadm --follow command to follow or monitor arrays and disks. 

Follow these instructions to issue the command on the operating system. Also, see Section 5.3, 

View Help from the Command Line, on page 72. 
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 To Use rcadm with a Linux® Operating System 

By default, rcadm is installed in /usr/bin.  

 To Use rcadm with a Windows® Operating System 

• Change directories to C:\Program Files (x86)\RAIDXpert2. 

• Run the rcadm.exe command from there. 

or 

• Add C:\Program Files (x86)\RAIDXpert2 to the system or user path 

environment variables. 

5.2 Manage Arrays and Disks: rcadm --manage 

The rcadm --manage or rcadm -M command allows the user to view information about 

RAIDXpert2 and manage the arrays and disks. 

For example, the user can: 

• Set cache attributes for arrays. 

• Set priority levels for tasks on an array. 

• Hide and unhide arrays. 

• List arrays. 

• Initialize disks. 

• Query information about disks. 

• Add and remove spares from an array. 

• Set cache attributes for disks. 

 Understand Query Output 

When the rcadm --manage --query-all or rcadm -M -qa command is used, 

information about the disks and arrays for the system is displayed.  

To see information about a specific controller, disk, or array use the rcadm --manage --

query command, in conjunction with the appropriate options.  
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 rcadm Controller List Elements 

Table 27. rcadm Controller List Elements 

Element Description 

Number Controller number assigned by RAIDXpert2 

Type Model number of the controller 

Serial Number Serial number of the controller 

Port Count The number of ports supported by RAIDXpert2 

PCIe
®
 Vendor ID The PCIe vendor identification number 

PCIe Device ID The PCIe device identification number 

PCIe SubVendor ID The PCIe sub-vendor identification number 

PCIe SubDevice ID The PCIe sub-device identification number 

Bus PCI bus number, assigned to the  controller 

Slt Slot: Position of controller/device on assigned bus, normally 0 

Fun Function: Programming interface presented by controller/device 

SAS Address (WWID) The SAS Address (world-wide identification number) 

BIOS Version The version of the AMD RAID Configuration BIOS 

 

 rcadm Disk List Elements 

Table 28. rcadm Disk List Elements 

Element Description 

Disk Disk number assigned by RAIDXpert2, corresponding to SATA channel ID. 

State State of the disk (Online, Failed, Unknown) 

Disk Type Disk type (Disk, Legacy, New, ATAPI) 
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Table 28. rcadm Disk List Elements (continued) 

Element Description 

Port Type Port type (SATA, SATA II, SATA III, SSD, NVMe) 

Port Speed The negotiated speed of the port 

Note: For NVMe the port type is always N/A. 

Size Total size of the disk: 

• 1 MB = 1,000,000 bytes 

• 1 GB = 1,000,000,000 bytes 

Note: Because the ATA storage industry has standardized the meanings of 

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 

reports the same units. 

Free Space Total amount of space unused on the disk 

Largest Free Space Largest contiguous unused space on the disk 

GS Indicates if the disk is assigned as a global spare 

Trim None, Simple, Advanced 

Ca Current disk cache setting (NC = No Cache, R = Read Cache, W = Write 

Back Cache, RW = Read + Write Back Cache). 

Note: For NVMe the CA is always NC. 

Ctrl Chan Disk controller and channel number. 

Vendor  Disk vendor 

Model Number Disk model number 

Firmware Version Disk firmware version 

Serial Number Disk serial number 
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 rcadm Array List Elements 

Table 29. rcadm Array List Elements 

Element Description 

A Array number assigned by RAIDXpert2. 

Type RAID type. 

O.S. Name Name assigned by the operating system to the array. The name shows as 

“Hidden” if the array is hidden from the operating system. The name 

shows “??” if the array is Offline. 

Sys or System Device Indicates whether or not the array is being used as a system disk under 

Windows. 

State State of the array (Normal, Critical, Offline). 

Size or Capacity Total size of the disk: 

• 1 MB = 1,000,000 bytes 

• 1 GB = 1,000,000,000 bytes 

Note: Because the ATA storage industry has standardized the meanings of 

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2 

reports the same units. 

Hide  Whether the array is hidden from the operating system. 

Id Globally unique identifier for the array assigned by RAIDXpert2. 

Task Task type (Transform, Check, Check_Bitmap, Not_Active, Create, 

Restore) 

Note: See Section 2.7, Array Tasks: Starting and Stopping Tasks, on page 

26 for detailed definitions. 

Task State The state of the task (Started, Paused, Completed) 

% The progress of a current array task, such as a Create or Transform, shown 

as percent complete 

CA  Current array cache setting (NC=No Cache, R=Read Cache, W=Write Back 

Cache, RW=Read + Write Back Cache). 
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Table 29. rcadm Array List Elements (continued) 

Element Description 

CTS Cache tag size specifies the amount of data per disk in a stripe. Supported 

sizes are 64kB, 128kB or 256kB 

Any Array with only HDD/SSD will have default CTS of 64k 

Any Array with NVMe/HDD/SSD will have default CTS of 256k 

Scan Background scan enabled (Yes/No) 

Name User-supplied name for the array 

Dedicated Spare Indicates the number of dedicated spares assigned to the array  

(--verbose mode only) 

Disk Listing of disks that are part of the array 

Used Capacity used of a specific disk 

Offset Location on the disk where the array begins 

 

5.3 View Help from the Command Line 

 To view a List of the Major Modes of Operation 

Type: rcadm --help or rcadm -? 

5.3.1.1 To View Help for a Specific Mode and its Options 

Type: rcadm <mode> --help or rcadm < mode> -? 

For example, typing rcadm --manage --help or rcadm -M -? displays help and 

examples regarding that specific mode and its options. 

5.3.1.2 To view the rcadm Man Page on a Linux® System 

Type: man rcadm 
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5.4 Create New Arrays: rcadm --create 

The rcadm --create or rcadm -C command allows new arrays to be created. As many as 

eight arrays can be partitioned and created across all disks.  

Portions of disks can be used to create arrays, while other arrays are using different portions of the 

same disks. A maximum of eight arrays can be created. 

 Before You Begin 

Creation of arrays, even redundant arrays, allows users immediate access to the arrays. If the 

system reboots, the creation process continues where it left off.  

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to 

function properly but are not supported. 

Note: The array size of the new array is limited to 2.199 TB with some operating systems. Refer to 

the operating system documentation for details on maximum array sizes. 

Note: The ability to create RAID10 or RAIDABLE arrays may not be available on your system. 

 Example 

To create a 1 GB RAID1 array using disk members 1, 2, and 3, type:  
rcadm -C -r1 -d 1 2 -s 1000 

To see more examples, type: rcadm -C -? 

5.5 Delete Arrays: rcadm --delete 

The rcadm --delete or rcadm -D command allows the user to delete one or more arrays. 

CAUTION: Deleting an array permanently destroys all data that is on the array. This action 

cannot be undone and it is very unlikely the data can be recovered. 

 Before You Begin 

• If the operating system is using an array it cannot be deleted. 

• If an array is accidentally deleted, and the user wants to try and recover the data, create an 

array using the same disks, same size, and same cache, and use the --leave-existing-data 

option. This option writes new configuration information to the array while trying to use 

the exact same disk space as before.  
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 Example 

To delete array 1, type: rcadm -D -a 1 

To see more examples, type rcadm -D -? 

5.6 Transform Arrays: rcadm --transform  

The rcadm --transform or rcadm -T command allows the user to transform (migrate) an 

array from one RAID level to almost any other RAID level, and to expand the array dynamically, 

even under I/O load.  

 Before You Begin 

• An array cannot be transformed to a smaller-sized array. New arrays must be either the 

same capacity or larger. 

• When using the task control option, a Transform can only be paused or resumed but not 

removed. 

• If a spare has been assigned to the destination array, a fail-over task starts as soon as the 

Transform completes, provided the spare is available after the Transform. 

• If there are multiple arrays on a single controller, it might not be possible to transform 

some of the arrays to a larger size. If the size of an array might be expanded in the future, 

it is best to configure the available space as a single array. 

• The array size of the transformed array is limited to 2.199 TB on some operating systems. 

5.7 Follow or Monitor Arrays and Disks: rcadm --follow 

The rcadm --follow or rcadm -F command allows the user to follow or monitor arrays 

and disks. It polls the RAID subsystem for any status changes and logs them in the Windows 

System Event Log.  

 Before You Begin 

It is recommended that the user not run more than one instance of rcadm --follow at the same time. 

If the user runs more than one instance of the command, each instance captures some of the 

events, but no single instance captures all events. 

5.8 rcadm.efi Information 

  rcadm -? 

-?, --help 
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Displays all primary rcadm commands, or if used after an option, displays help for that 

specific option. 

-log, --log-file 

Print output to a log file as well as standard output. Requires a log file name argument. 

Overwrites existing file. Only one occurrence of this option on the command line is allowed. 

Example: rcadm -M -qa -v -log status.txt 

-C, --create 

Command for creating arrays. Array types include linear (JBOD), volume (JBOD), RAID0, 

RAID1, RAID10, RAID10n, and RAIDABLE. Some of the major functions include assigning 

spare disks; setting array size; and setting cache attributes. 

-D, --delete 

Command for deleting arrays. This mode does not have any optional arguments. 

-M, --manage 

Commands for managing and querying controllers, arrays, and disks. Some of the major 

functions include querying for information, adding and removing dedicated and global spare 

disks, setting cache attributes for arrays and disks, performing consistency checks on 

redundant array types, initializing disks, prioritizing tasks for arrays, scanning arrays and disks 

for changes in status, and hiding or unhiding arrays. 

 rcadm -M 

MANAGE 

-a, --array 

Used with certain options to specify arrays. 

-as, --add-spare 

Adds a dedicated spare disk to an array. No space is reserved on the disk selected. 

-rs, --remove-spare 

Removes a dedicated spare disk from an array. 

-ras, --remove-all-spares 

Removes any spares from an array. 

-ags, --add-global-spare 
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Adds a disk as a global spare. No space is reserved on the disk selected. 

-rgs, --remove-global-spare 

Removes a global spare disk. 

-ca, --cache-array 

Sets the cache attributes for an array. Cache attributes include read cache (r), read and write-

back cache (rw), write-back cache (w), and no cache (nc). 

-cd, --cache-disk 

Sets the cache attributes for a disk. Cache attributes include read cache (r), read and writeback 

cache (rw), write-back cache (w), and no cache (nc). 

-d, --disk 

A required qualifier used with certain options to specify disks. 

-h, --hide 

Hides an array from the operating system. 

-uh, --unhide 

Unhides an array, making it visible to the operating system. 

-id, --initialize-disk 

Initializes a disk. If the disk is new and has not been used, you must initialize it before you can 

create arrays. 

-cm, --clear metadata 

Clears metadata from a disk. Disk is no longer usable in RAID arrays until it is initialized. 

-n, --name 

Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 

17 of those characters display in the BIOS. 

-p, --priority 

Sets an array's task priority from 1-10, with 10 being the highest priority. 

-q, --query 

Lists information about specific controllers, arrays, and disks. 

-qa, --query-all 

Lists information about controllers, arrays, and disks. 
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-v, --verbose 

Modifier of the --query and --query-all option. Specifies more detail for arrays and disks. 

-rsc, --rescan 

Rescans the serial ATA (SATA) channels for new or removed disks. 

-sg, -- smart-get 

Reads SMART attribute and log information for the specified drive(s). 

-sa, --scan-array <on|off> 

Specifies if background array scan scanning is on or off. 

-sp, --smart-poll 

Turns SMART polling on or off for the specified drive(s). 

-t, --task 

Used to pause, resume, and remove tasks. 

-ul, --unlink 

Unlinks two arrays linked through a create copy operation. 

SYNTAX and EXAMPLES 

ADD SPARE 

--add-spare --array <list> --disk <list>  

-as -a <list> -d <list> 

Examples: rcadm --manage --add-spare --array * --disk 1 

rcadm -M -as -a 1 2 -d 5 6 

REMOVE SPARE 

--remove-spare --array <list> --disk <list> 

-rs -a <list> -d <list> 

Examples: rcadm --manage --remove-spare --array 5 --disk * 

rcadm -M -rs -a * -d 5 

REMOVE ALL SPARES 

--remove-all-spares --array <list> 

-ras -a <list> 

Examples: rcadm --manage --remove-all-spares --array 5 
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rcadm -M -ras -a * 

ADD GLOBAL SPARE 

--add-global-spare --disk <list> 

-ags -d <list> 

Examples: rcadm --manage --add-global-spare --disk 1 2 3 

rcadm -M -ags -d * 

REMOVE GLOBAL SPARE 

--remove-global-spare --disk <list> 

-rgs -d <list> 

Examples: rcadm --manage --remove-global-spare --disk * 

rcadm -M -rgs -d 5 

CACHE SETTINGS FOR ARRAYS 

--cache-array <cache_attribute> --array <list> 

-ca <cache_attribute> -a <list> 

Cache attributes: <r> for read cache 

<rw> for read and write-back cache 

<w> for write-back cache 

<nc> for no cache 

Examples: rcadm --manage --cache-array rw --array * 

rcadm -M -ca nc -a 1 

Note: rcadm -M -rsc is required for the change to be presented to the OS. 

DISK SETTINGS (Advanced) 

Disk cache: 

--cache-disk <cache_attribute> --disk <list> 

-cd <cache_attribute> -d <list> 

Cache attributes: <r> for read cache 

<rw> for read and write-back cache 

<w> for write-back cache 

<nc> for no cache 

Examples: rcadm --manage --cache-disk r --disk 1 2 3 
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rcadm -M -cd w -d * 

HIDE ARRAY 

--hide --array <list> 

-h -a <list> 

Examples: rcadm --manage --hide --array 5 6 

rcadm -M -h -a 4 

UNHIDE ARRAY 

--unhide --array <list> 

-uh -a <list> 

Examples: rcadm --manage --unhide --array * 

rcadm -M -uh -a 5 

INITIALIZE DISK 

--initialize-disk --disk <list> 

-id -d <list> 

Examples: rcadm --manage --initialize-disk --disk * 

rcadm -M -id -d 1 2 3 

NAME ARRAY 

--name "name" --array <list> 

-n "name" -a <list> 

Examples: rcadm --manage --name "System Disk" --array 5 

rcadm -M -n "Backup Disk" -a 4 

QUERY 

--query [--array <list>] [--disk <list>] 

[--verbose] 

-q [-a <list>] [-ct <list>] [-d <list>] [-v] 

Examples: rcadm --manage --query --array 1 --disk --verbose 

rcadm -M -q -a 1 2 3 -d -v 

QUERY ALL 

--query-all 

-qa 

Example: rcadm --manage --query-all 
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RESCAN DISKS 

--rescan 

-rsc 

Example: rcadm --manage --rescan 

SMART GET 

--smart-get --disk <list> {--log-number <log_number=0..5> | --

attributes} 

-sg -d <list> {-l <log_number=0..5> | -at}  

Example: rcadm --manage --smart-get --overview --log-number 

* --disk * 

  rcadm --manage --smart-get --attributes --disk 1 2 

SCAN ARRAY 

--scan-array <on|off> --array <array_number> 

-sa <on|off> -a <array_number> 

Example: rcadm -M --array 1 --scan-array on 

rcadm -M -a 1 -sa off 

SMART POLL 

--smart-poll <on|off> --disk <list> 

-sp <on|off> -d <list> 

Example: rcadm --manage --smart-poll on --disk 

rcadm -M -sp off -d 1 2 3 

TASK CONTROL 

--task <task_operation> --array <array_number> 

-t <task_operation> -a <array_number> 

Task Operation 

<pause> to temporarily pause a task 

<resume> to continue running a task 

<remove> to permanently remove a task 

Examples: rcadm --manage --task pause --array 5 

rcadm -M -t remove -a 4 
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TASK PRIORITY 

--priority <1..10> --array <list> 

-p <1..10> -a <list> 

Examples: rcadm --manage --priority 5 --array 6 

rcadm -M -p 1 -a 

UNLINK ARRAY 

--unlink --array <array_number> 

-ul -a <array_number> 

Examples: rcadm --manage --unlink --array 2 

rcadm -M -ul -a 5 

 rcadm -C 

CREATE 

Long form: 
rcadm --create <raid_type> --disk <list> [--size <size_mb>] 

[--sub-member <num>] [--spare-disk <list>] 

[--no-sync] [--d-spare] [--cache <r,rw,w,nc>] 

[--max-size] [--name "name"] [--priority <1..10>] 

[--zero][--scan-array] 

Short form: 

rcadm -C <raid_type> -d <list> [-s <size_mb>] [-sub <num>] 

[-sp <list>] [-ns] [-ds] [-ca <r, rw, w, nc>] [-ms] 

[-n "name"] [-p <1..10>] [-z] [-sa] } 

RAID Types: 

--volume, -v Single disk or concatenation of disks (JBOD) 

--raidable, -ra Single disk, RAIDABLE 

--raid0, -r0 Stripe of two or more disks 

--raid1, -r1 Mirror of two disks 

--raid5, -r5 Stripes data as well as parity, across all disks in the array 

--raid10, -r10 Stripe set of mirror sets 
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OPTIONS 

-sp, --spare-disk 

Specifies the dedicated spare disk or disks to assign, with a maximum of four. No space is 

reserved on the selected disks. 

-s, --size 

Specifies the size of the array in MBs. If you do not use this option, the largest possible size is 

used by default. 

-ns, --no-sync 

Disables background synchronization of redundant types when creating the array. 

-ca, --cache 

Specifies a cache setting for the array(s): read cache <r>, read and write-back cache <rw>, write-

back cache <w>, or no cache <nc>. The default is read and write-back cache <rw>. 

-cts,  --cachetagsize 

Specifies the Cache Tag Size. This is the amount of data per disk in a stripe. Supported sizes are 

64, 128, or 256; sizes in kB. 

Please refer to Table 14, Default Cache Tag Size, on page 36. 

-ms, --max-size 

Prints the maximum possible size for an array without actually creating an array. 

-n, --name 

Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 17 of 

those characters display in the BIOS. 

-p, --priority 

Sets the background initialization task priority from 1 to 10, with 10 being the highest priority. For 

redundant array types only. 

-led, --leave-existing-data 

Leaves the existing data on the disks untouched after the array is created. This option can be used 

to try to recover user data when an array has been accidentally deleted or the configuration 

information is lost but the data is still intact. Unless you immediately recreate the array after 

deleting it and no other tasks have been performed, the likelihood of recovering data with this 

method is very low. 

-d, --disk 

A required qualifier used with the --create option to specify the disk or disks to be included in the 

array. 
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-sa, --scan-array 

Specifies that a background array scan should be continuously run whenever the array is idle 

(Default is off). 

-z, --zero 

Zero the array in the foreground. This method is faster than doing a background consistency 

verifies if the array is a redundant type. For non-redundant types, the zero option can be used to 

verify all blocks in the array can be accessed. 

EXAMPLES 

Example: Create a RAID1 set of the maximum possible size using all disks. 

rcadm -C –raid1 --disk * 

Example: Create a RAID1 set of the maximum possible size, with a spare disk and without a 

background initialization task. 

rcadm -C --raid1 --spare-disk 3 --disk 1 2 --no-sync 

 rcadm -D 

DELETE 

Long form: 

--delete --array <list> [--no-ask] 

Short form: 

-D -a <list> [-na] [-cg <group number>] 

OPTIONS 

-na, --no-ask 

If the no ask option is specified the array is deleted without confirmation. 

EXAMPLES: 

Example: Delete arrays 1 and 2. 

rcadm -D --array 1 2 

Example: Delete all arrays. 

rcadm -D --array 
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Chapter 6 Troubleshooting 

6.1 Troubleshooting 

The chapter discusses major categories of troubleshooting: 

• Problems with system startup. 

• Warning messages that might appear at the Power-On Self-Test (POST) screen. 

• Problems with arrays. 

• Problems with disks. 

• Template for adding the warning message when someone tries to create a RAID5 on a 

system that is not supported. 
 

Note: When booting from an AMD RAID boot array, it takes about 4 seconds longer than a native 

installation to boot. 

6.2 System Startup Problems 

This section correlates possible startup issues and corrective actions for system boot. 

Table 30. System Does Not Boot 

Possible Causes  Corrective Actions 

Controller mode is set 

incorrectly during system 

startup 

In the system’s BIOS screen, ensure SATA is set to RAID and NVMe 

RAID is set to Enabled. 

The system’s boot mode 

or boot sequence retry 

mode is set incorrectly 

In the system’s BIOS screen, ensure that the bootable array is the first 

array listed. 

Swap arrays is not supported in UEFI. 

A bootable array is in an 

Offline state 

Restart the system. 

Enter the system’s BIOS screen. 

Check the state of the bootable array. 

Check for missing or offline disks. 
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Table 31. System No Longer Boots in RHEL 

Possible Causes  Corrective Actions 

AMD RAID Drivers are 

not synchronized with the 

Linux Kernel. 

Synchronize the drivers with kernel: 

1. Click the Terminal icon. 

a. Enter: yum update 

b. Enter: yum groupinstall “Development Tools” 

Warning: If the system kernel version is updated, perform step 2 

before the system is rebooted. Failing to do so may result in the 

system failing to boot. 

2. Change to the RAIDXpert2 driver_sdk directory, and 

enter: 

a. Enter: cd /opt/raidxpert2/driver_sdk  

b. Enter: sudo ./install  

3. Wait for the command to complete, then reboot the 

system. 

See Quick Start Guide for more information. 

 

Table 32. BIOS Configuration Utility Does Not Display 

Possible Causes  Corrective Actions 

The controller mode is set 

incorrectly in the system 

BIOS 

In the system’s BIOS screen, ensure SATA is set to RAID and NVMe 

RAID is set to Enabled. 

Possible Causes Native AHCI installation. 

Corrective Actions A Native AHCI installation will not boot into the OS, after changing 

the BIOS settings to RAID mode. 
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6.3 Warning Messages: POST Screen 

The POST screen is one of the first screens to appear during the system’s boot sequence. If the 

system’s arrays were in Normal or Ready state prior to a system boot, the boot sequence 

continues normally to the operating system. 

But, if an array is in Critical or Offline state, or if specific options at Controller Options were 

changed previously at the BIOS Configuration Utility, the warning messages displayed by OProm 

are described in Table 33 appear during the boot sequence. 

Table 33. POST Screen Warning Messages 

Warning 

Message 
Additional Information Corrective Action 

WARNING: 
Found arrays 

that are Critical 

[or equivalent] 

This warning message appears when at least one array 
is in a Critical state and Toggle Pause if Critical is set 

to ON at the BIOS Configuration Utility. 

The Critical state of an array depends on the RAID 

level of the array and the number of disks that have 

failed. See Section 2.3, Array States, on page 23, for 

information on criticality. 

If an array is Critical (even a bootable array), the 

system can continue through the boot process to the 

operating system.  

See Section 6.5.1, Troubleshooting 

Disks, on page 91. 

WARNING: 

Found 

 arrays that are 

Offline  

[or equivalent] 

This warning message appears when at least one array is in 

an Offline state and Toggle Pause if Offline is set to ON at 

the BIOS Configuration Utility.  

If two or more disks in a redundant array have failed, or if 

a single or multiple disk in a non-redundant array have 

failed, data has been lost. 

In RAID10 array, if a single disk fails in each mirrored set, 

the redundant array goes to a Critical state but data is not 

lost. If two disks fail in one of the mirrored sets, the 

redundant array goes to an Offline state and data is lost. 

See Section 6.5.1, Troubleshooting 

Disks, on page 91. 

If, after performing a rescan, the state 

remains Offline, the bootable array has 

suffered an unrecoverable failure.  

Create a new bootable array. 

Reinstall the operating system and 

drivers. 

WARNING: 

Found  

arrays that are 

Critical and 

Offline 

[or equivalent] 

A bootable array that is in an Offline state prevents the 

operating system from booting. 
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Table 33. POST Screen Warning Messages (Continued) 

Warning Message Additional Information Corrective Action 

BIOS NOT 

INSTALLED - User 

Disabled INT13 

BIOS Load  

[or equivalent] 

This warning message appears when Toggle 

INT13 Boot Support option has been set to OFF 

at the BIOS Configuration Utility and another 

boot device is not selected. 

Bootable devices do not function with the 
controller when Toggle INT13 Boot Support is 

set to OFF. The default setting is ON, which 

allows bootable devices to function with the 

controller. 

Restart the system. 

Enter the system’s BIOS screen. 

Select Main Menu > Controller Options > 

Toggle INT13 Boot Support. 

Change Toggle INT13 Boot Support from 

OFF to ON. 

Navigate to Main Menu.  

Select Continue to Boot.  

The system boot process continues to the OS. 

6.4 Array-Related Errors 

• Table 34. Cannot Create an Array, on page 87 

• Table 35. An Array is in a Critical State on page 88 

• Table 36. An Array is in an Offline State, on page 88 

• Table 37. Cannot Assign a Dedicated Spare to an Array, on page 89 

• Table 38. Cannot Create a Global Spare on page 89 

• Table 39. Recreate a Deleted Array, on page 90 

• Table 40. Deleted Secondary Array Availability Using HII During Hibernation Resume 

on page 90 
 

Table 34. Cannot Create an Array 

Possible Causes Additional Information Corrective Actions 

The disk is not displayed.  The controller cannot communicate 

with the disks. 

See Section 6.5.1, Troubleshooting 

Disks, on page 91. 

Insufficient free space 

available on the selected 

disks 

 Select a different combination of 

disks. 

Incorrect number of 

disks selected for the 

desired RAID level 

See 2.2, RAID Levels, on page 22, 

for a description of RAID levels and 

the allowable number of disks used 

with each RAID level. 

Select the correct number of disks. 
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Table 34. Cannot Create an Array (continued) 

Possible Causes Additional Information Corrective Actions 

The desired disk is 

unavailable. 

The disk is a dedicated spare for a 

different array. 

The disk is full. 

The disk’s available capacity is 

insufficient. 

Select a different disk. 

The disk has SMART 

errors. 

An array can be created with a disk 

that has SMART errors, but only if 
the array is created in the BIOS 

Configuration Utility.  

RAIDXpert2 cannot be used to 

create an array with a disk that has 

SMART errors. 

Use the BIOS Configuration Utility to 

create the array. 

The system already has a 

maximum of eight arrays  

 Delete unused arrays. 

CAUTION: Deleting an array 

permanently destroys all data on the 

array. This action cannot be undone. 

It is unlikely data can be recovered. 

 

Table 35. An Array is in a Critical State 

Possible Causes Additional Information Corrective Actions 

One or more disks in the 

array have failed or been 

removed. 

Due to the failed disk or disks, the array no longer 

maintains redundant (mirrored or parity) data.  

The failure of an additional disk results in an 

Offline state and lost data.  

See Section 6.5.1, 
Troubleshooting Disks, 

on page 91. 

 

Table 36. An Array is in an Offline State 

Possible Causes Additional Information Corrective Actions 

The array has lost the 

maximum allowable 

disks per RAID level. 

One or more disks have failed. 

• If the array is non-redundant, the failure of a 

single disk causes the array to fail. 

• If the array is redundant, the failure of two or 

more disks causes the array to fail.  

The array cannot be restored (rebuilt). 

See Section 6.5.1, 

Troubleshooting Disks, 

on page 91. 
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Table 37. Cannot Assign a Dedicated Spare to an Array 

Possible Causes Additional Information Corrective Actions 

The RAID level does not 

allow dedicated spares. 

Dedicated spares cannot be created for 

Volume or RAID0 arrays.  
• Create an array with a different 

RAID level and assign a 

dedicated spare. 

• Create a global spare. 

The designated disk does 

not have sufficient 

capacity to be a dedicated 

spare 

The capacity of the disk selected to be a 

dedicated spare must be equal to or 

larger than the capacity of the smallest 

disk in the array.  

Select a different disk. 

 

Table 38. Cannot Create a Global Spare 

Possible Causes Additional Information Corrective Actions 

The disk is already part 

of an array 

A global spare cannot be selected if it 

is already part of an existing array. 

Select a different disk. 

There are no empty disks 

available or the disks 

have not been initialized 

A disk with a legacy state can be 
initialized, if desired, but it is no 

longer legacy (initialization adds 

RAIDXpert2 configuration 

information to the disk). 

Install additional disks. 

Initialize the disks.  

CAUTION: When a disk is initialized, 

all data on the disk is lost. 

The disk assigned as the 

global spare has failed or 

is missing. 

 See Section 6.5.1, Troubleshooting 

Disks, on page 91. 
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Table 39. Recreate a Deleted Array 

Possible Causes Additional Information Corrective Actions 

An array(s) was 

accidentally deleted, or 

the wrong array was 

deleted 

This procedure might 

recreate a deleted array and 
with its data intact. 

However, this is not 

guaranteed to occur. 

If I/O was running to the 
deleted array(s) just prior 

to it being deleted, there 

might be some data loss in 

the recreated array(s). 

If multiple arrays were 
deleted, all of the deleted 

arrays must be recreated in 

order to recover the desired 

array. 

1. At the Array pop-up menu, select Create. 

2. Create a new array using the same settings 

as the deleted array. 

• The same disks. 

• The same RAID type (RAID level). 

• The same capacity. 

• The same cache options. 

3. Check Leave Existing Data Intact. 

4. Click Create. 

5. Ensure the settings are the same as the 

deleted array: 

• The same drive letter. 

• The same RAID type (RAID level). 

• The same disks. 

• The same capacity. 

• The same cache option  

6. Check the data files of the array for 

corrupted or missing files, incorrect file 

extensions, and so on. 

 

Table 40. Deleted Secondary Array Availability Using HII During Hibernation Resume 

Possible Causes Corrective Actions 

Array(s) are seen online in Operating 

system after array deletion in 
RAIDXpert2 Configuration Utility (HII) 

during hibernation resume. 

After array deletion in RAIDXpert2 Configuration Utility 

(HII) during hibernation resume, system needs to be reset for 

the changes to take effect. 
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6.5 Disk Related Errors 

Table 41. Disk Errors 

Possible Causes Additional Information Corrective Actions 

A disk has been 

removed from an array 

 

See Section 6.5.1, Troubleshooting Disks. 
A disk is not visible in 

the BIOS Configuration 

Utility or is offline 

 

A disk is highlighted 

red at the BIOS 

Configuration Utility 

The disk has failed. 

Depending on the RAID level of 

the array, data might be lost. 

 

RAIDXpert2 cannot 

communicate with the 

spare 

The dedicated spare is not visible 

in the BIOS Configuration Utility 

or is offline. 

 

The disk cannot be 

initialized 

Only disks that are Ready can be 

initialized. 

CAUTION: When a disk is 

initialized, all data on the disk is 

lost. 

• Ensure disk is not already a member 

of an array.  

• Ensure disk is still assigned as a 

global or dedicated spare. 

• Ensure disk is reporting a Ready state. 

 Troubleshooting Disks 

Perform the following actions when there may be a problem with a disk. 

• Ensure there is no damage to the system’s backplane. 

• Ensure all cables are installed correctly. 

• Ensure the disk is seated correctly in the backplane or bay and the latch is secured.  

• Reinsert the disk. 

• Replace the disk. 

• After reconnecting, reseating, reinserting, or replacing a disk, perform a re-scan and 

initialize the disk. 

CAUTION: When a disk is initialized, all data on the disk is lost. 

If problems with a disk caused an array to go Critical, it may be necessary to also assign a 

dedicated or global spare for the array. 

If problems with a disk caused an array to go Offline, data may have been lost. Recover lost data 

from a backup storage source. 
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6.6 Troubleshooting the RAIDXpert2 GUI 

Table 42 lists some GUI problems and corrective actions. 

Table 42. RAIDXpert2 Graphical User Interface (GUI) Troubleshooting 

Problem Possible Cause Corrective Actions 

License Level 0 when 

logging in. 

The RAIDXpert2-CGI (rc_cgi) 

service stopped working or not 

running. 

Restart the rc_cgi service. 

Cannot reach this 

page or similar. 

The Apache service has stopped 

working or not running. 

Restart the Apache service. 

GUI blank, no array 

or disk information. 

Array name contains a 

forbidden character. 

Open a Command Prompt in Windows. 
 

Type cd C:\Program Files 
(x86)RAIDXpert2 
 

Enter the following command: rcadm.exe 
-M -n “NewName” -a # 
 

Where # is the Array that has the forbidden 

character in its name. 
 

Press Enter. 
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Chapter 7 Safety Precautions 

This section includes general safety precautions and specific RAIDXpert2 precautions. Many are 

shown in context throughout this guide. Read and keep this guide for future reference. 

In this section, CAUTION indicates that a failure to follow directions could result in damage to 

equipment or data. 

7.1 Storage Device Precautions 

CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an 

automatic restore is not guaranteed if a disk fails. If a disk fails, create space on the 

disk for the fail-over to complete, or assign a different disk with enough space. If a 

dedicated spare is assigned and a disk fails, the restore process starts automatically if 

there is enough space available on the dedicated spare. 

CAUTION: If a disk is part of an AMD RAID array, the disk cannot be selected for initialization. 

To initialize the disk anyway, delete the AMD RAID array. Data on the disk is deleted 

during initialization, so ensure the correct disks are chosen to initialize. 

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, or when its 

corresponding legacy disk is initialized, the data is lost. 

CAUTION: When a disk is initialized, all data on the disk is lost. 

CAUTION: AMD recommends not using SMR hard drives with AMD RAID systems because it 

can cause poor performance or failures. SMR drives are not suitable for workloads 

that require many random writes (such as boot drive). If used with RAID, the multiple 

SMR drives and background RAID tasks (such as creates and rebuilds) compound any 

issues or problems. 

General notes and guidelines: 

• Volume, RAID0, RAID5, or RAID10 arrays can be created or transformed by a maximum 

of eight (8) NVMe and/or SATA disks. (RAID 5 is only available for TRX40 and WRX80.) 

• RAID1 can be created or transformed by a maximum of two (2) NVMe and/or SATA disks. 

• RAID on AMD platforms supports M.2 ports, both AMD SATA controller and PCIe M.2 

NVMe. At any time, each M.2 port can support either M.2 SATA or M.2 NVMe, but not both. 

• Individual disks that are not part of a RAID array are not listed in Device Manager under the 

Disk Drive section. Individual Disks can be managed through the RAIDXpert2 UWP-based 

interface (Windows only), RAIDXpert2 utility (HII), and the EFI shell. 
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• Instead of a shutdown, AMD recommends performing a reset/reboot of the system whenever 

the user is adding or moving a SATA M.2 SSD or NVMe device(s). 

– In the OS, issue a reset/reboot. 

– Wait for the AMD BIOS screen to display, press ESC to enter the BIOS. 

– Power off the system. 

– Install or remove the necessary device(s). 

– Power on the system and allow the OS to boot properly. 

• When "NVMe RAID" = enabled, all NVMe devices connected to the system are controlled by 

the AMD RAID driver (includes all U.2 NVMe drives, M.2 NVMe drives, and PCIe NVMe 

add-in cards). 

• When SATA = RAID, all SATA devices connected to the system are controlled by the AMD 

RAID driver (includes all HDD, SSD, ATAPI devices). 

7.2 Array Precautions 

CAUTION: Deleting an array permanently destroys all data that is on the array. This action 

cannot be undone, and it is very unlikely the data can be recovered. 

CAUTION: Do not delete the first array listed in the Arrays section if it is the AMD RAID 

bootable array. Doing this deletes the operating system and AMD RAID files. 

CAUTION: Do not initialize a disk that is part of an array. Initializing a disk in a non-redundant 

array deletes the array and its data. The array no longer appears in Array View. This 

is especially true for a non-redundant bootable array. Initializing a disk in a non-

redundant bootable array causes the array to fail and deletes the operating system, 

AMD RAID files, and device drivers. 

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being 

corrupted if the system experiences a power interruption or unexpected shutdown. 

CAUTION: In Windows®, prior to removing an array, remove its drive letter. 

CAUTION: In Linux®, prior to removing an array, unmount the array. 

CAUTION: All data contained in an AMD RAID array are lost if any member of the array is 

migrated to a non-AMD RAID system. 

CAUTION: When an array is securely erased, the data on the array is lost. The array remains 

hidden after the secure erase completes. The user must unhide the array for it to be 

available for data operations. 

CAUTION: In some circumstances, more than eight arrays are possible. They might appear to 

function properly but are not supported. 
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CAUTION: If the user creates an array using Skip Initialization, any new data written is 

redundant. But if a Consistency Check is performed, errors may be reported because 

the unwritten areas of the array have not been made consistent. 

CAUTION: Windows can only be installed to the first AMD RAID array. 

CAUTION: AMD RAID does not support TBT devices. 

CAUTION: AMD RAID does not support NVMe hot swapping. 

7.3 Controller Precautions 

CAUTION: Hot-swapping is not recommended for disks that are part of AMD RAID boot array. 

CAUTION: A Native AHCI installation does not boot into the OS after changing BIOS settings to 

RAID mode. 
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Chapter 8 Software License: EULA 

8.1 Software License: End-User License Agreement 

(EULA) 

BY INSTALLING, DOWNLOADING AND/OR USING THE SOFTWARE THAT 

ACCOMPANIES THIS END USER LICENSE AGREEMENT (“AGREEMENT”) AND ANY 

ASSOCIATED DOCUMENTATION OR UPDATES THERETO ("SOFTWARE"), YOU 

AGREE THAT, WHETHER AS AN INDIVIDUAL OR AUTHORIZED REPRESENTATIVE 

OF AN ENTITY, YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE 

TO BE BOUND BY IT. IF YOU DO NOT AGREE TO IT, YOU ARE NOT AUTHORIZED TO 

INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE AND ARE ASKED TO 

PLEASE RETURN THE SOFTWARE TO THE PARTY FROM WHOM YOU RECEIVED IT. 

THE RIGHT TO USE THE SOFTWARE IS GRANTED ONLY UPON THE CONDITION 

THAT YOU AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. 

FURTHER, YOU UNDERSTAND THAT THIS SOFTWARE MAY ONLY BE OBTAINED 

FROM Advanced Micro Devices, Inc. (“AMD”) OR AN AUTHORIZED DISTRIBUTOR OF 

AMD. IF YOU OBTAINED THIS SOFTWARE FROM ANY OTHER SOURCE, THAT 

SOURCE PROVIDED IT TO YOU ILLEGALLY, AND YOU HAVE NO RIGHT TO 

INSTALL, DOWNLOAD OR OTHERWISE USE THE SOFTWARE; SUCH USE IS A 

VIOLATION OF INTELLECTUAL PROPERTY RIGHTS. 

 Limited License to Authorized Distributors 

If you are an OEM, distributor, reseller, integrator or other entity in the business of providing 

technology products and/or services, and if you have been expressly authorized to distribute copies 

of the Software to End User(s), you are an "Authorized Distributor." Subject to the terms and 

conditions of this Agreement, you are granted a limited, non-exclusive, non-transferable, non-sub 

licensable license to distribute and/or install the Software in its unaltered, object code form solely 

(i) to, and on behalf of, a purchasing End User for the End User’s internal business purposes; and 

(ii) only for use with one (1) AMD product, purchased through authorized AMD sales channels. 

Except as specifically stated in this Section 1, Authorized Distributors are expressly prohibited 

from: copying and/or distributing the Software in whole or in part; using the Software to provide 

consulting or other services to third parties; and distributing the Software in any form or format. 

Authorized Distributors are subject to all other terms and conditions of this Agreement. 

Authorized Distributors must ensure that its End Users see and agree to this Agreement. 

 Limited License to End Users 

If you have licensed the Software for your own personal use or your company's internal use, you 

are an "End User." You are hereby granted, subject to the terms and conditions of this Agreement, 
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a limited, non-exclusive, non-transferable, non-sublicensable license to use this Software in its 

unaltered, object code form solely (i) for internal business purposes; and (ii) only with respect to 

one (1) AMD product that was purchased through authorized AMD sales channels. Further, you 

must obtain this Software only from authorized AMD sales channels. Obtaining it from any other 

source is a violation of the intellectual property rights of AMD and its licensors. 

 Restrictions 

Except as expressly authorized in Sections 1 and 2 above, Authorized Distributors and End Users 

(collectively "You”) shall not (nor cause or permit any other person to): (i) reverse engineer, 

translate, disassemble, derive source code from, decompile, rent, lease, manufacture, adapt, create 

derivative works from, or otherwise modify or distribute the Software or any part thereof; (ii) 

copy, in whole or in part, the Software with the exception that only End Users may make one copy 

of the Software for their backup or archival purposes; (iii) publicly display the Software or use the 

Software to provide consulting or other services to third parties; or (iv) delete any copyright, 

trademark, patent or other notices of proprietary rights as they appear anywhere in or on the 

Software. 

 Proprietary Rights 

The Software is primarily the intellectual property of Seagate Technology PLC. (“Seagate”) and 

its licensors (“Licensors”). In no event shall You obtain title to the Software or any component 

thereof. As between Seagate and You, Seagate has all rights, title, interest, ownership and 

proprietary rights in and to the Software. Seagate's rights include, but are not limited to, all copies 

of the Software and any patent rights, copyrights, trademark rights, trade secret rights, and any 

other intellectual property right recognized in any country or jurisdiction in the world. 

The Software is protected by both United States law and international treaty provisions. 

All rights not expressly granted in this Agreement are reserved by Seagate and Licensors, 

respectively. 

Certain modifications to the Software are the intellectual property of Advanced Micro Devices, 

Inc.  As between AMD and You, AMD has all rights, title, interest, ownership and proprietary 

rights in and to those modifications including but not limited to any patent rights, copyrights, 

trademark rights, trade secret rights, and any other intellectual property right recognized in any 

country or jurisdiction in the world. 

 Terms and Conditions 

This Agreement shall continue in effect until terminated. AMD may terminate this Agreement 

immediately if You fail to comply with any provision of this Agreement. Upon termination, You 

shall discontinue use of the Software, and either destroy, erase, or return all copies of the Software 

in Your possession or control. 
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 No Warranty 

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED. SEAGATE AND AMD DISCLAIM, ON THEIR OWN BEHALF 

AND ON BEHALF OF LICENSORS, ANY EXPRESS OR IMPLIED WARRANTIES 

INCLUDING ANY IMPLIED WARRANTIES OF NONINFRINGEMENT, 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE SOFTWARE 

OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR 

ERROR-FREE OR WILL OPERATE IN COMBINATION WITH OTHER SOFTWARE OR 

HARDWARE. Seagate and its Licensors will not provide support for the Software and, to the 

extent you believe that are entitled to support, you are advised to contact the party from whom you 

received the Software. Notwithstanding the foregoing, Updates to the Software (which may or 

may not be distributed) shall be governed by this Agreement, and such Updates will be considered 

Software for purposes of this Agreement. 

The Software is not absolutely fault-tolerant and is not designed, manufactured or intended for use 

or resale as on-line control equipment in hazardous environments requiring fail-safe performance 

in which the failure of the Software could lead directly to death, personal injury or severe physical 

or environmental damage, such as the operation of nuclear facilities, aircraft navigation, air traffic 

control, direct life support machines, or weapons systems (“High Risk Activities”). Express or 

implied warranties for High Risk Activities are specifically disclaimed. 

 Limitation of Liability 

IN NO EVENT SHALL SEAGATE, AMD OR LICENSORS BE LIABLE TO ANY PARTY 

FOR ANY LOST REVENUE, LOST PROFIT OR DATA, OR FOR SPECIAL, INDIRECT, 

CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED, AND 

REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR 

INABILITY TO USE THE SOFTWARE EVEN IF THEY HAVE BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL SEAGATE’s, AMD’s or 

LICENSORS’ LIABILITY, TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING 

NEGLIGENCE) OR OTHERWISE, EXCEED THE AMOUNT OF ANY FEE PAID BY YOU 

FOR THE SOFTWARE. THE FOREGOING LIMITATIONS SHALL APPLY EVEN IF THE 

REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some jurisdictions do not allow for the 

exclusion of implied warranties as described in Section 6, or the limitation of liabilities as 

described in this Section 7, so the above exclusions or limitations may not apply to You. In that 

event, to the extent permissible, any exclusion of warranties or limitation of liability will be 

limited in duration or type to the greatest extent allowed by law. 

 Export Controls 

You agree to comply fully with all relevant export laws, regulations, treaties, and orders ("Export 

Laws") to assure that neither the Software nor any components thereof are (i) exported, directly or 

indirectly, in violation of Export Laws; or (ii) are intended to be used or are used for any purposes 

prohibited by the Export Laws. 
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 General 

This Agreement and any disputes arising from or relating to it shall be governed by and construed 

in accordance with the laws of the State of Colorado without reference to conflict of laws 

principles and excluding the U.N. Convention on Contracts for the International Sale of Goods. 

Any legal action or proceeding shall be instituted in a state or federal court in Denver, Colorado, 

U.S.A. and You agree to be subject to the jurisdiction of these courts. Taxes and charges imposed 

by any government with respect to the Software shall be paid by the End User. The waiver by 

either party of a breach of this Agreement or a failure to exercise any right hereunder shall not 

operate or be construed as a waiver of any subsequent breach or as a waiver of any other right. If 

any provision of this Agreement is held to be unenforceable or overbroad for any reason, it will be 

modified rather than voided, if possible, in order to achieve the intent of the parties to the extent 

necessary to make the provision enforceable under applicable law and enforced as amended. In 

any event, all other provisions of this Agreement will be deemed valid and enforceable to the full 

extent. This Agreement constitutes the complete agreement between the parties and supersedes all 

prior or contemporaneous agreements or representations, written or oral, concerning the subject 

matter of this Agreement including any purchase order or ordering document. This Agreement 

may not be modified or amended except in writing and signed by both parties. 
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Appendix A Browser Setup 

Browser Setup 
• Use Chrome version 20, Firefox version 14, Internet Explorer 8, or Safari 6, or a greater 

version of each. 

• To optimize the display, use a color monitor and set its color quality to the highest setting. 
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